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URL: https://litmospheres.com/

Platform: unknown

Archetype: fun

Run ID: 2026-04-19T06-18-18-831Z

Scanned: 2026-04-19T06:46:48.878Z

Duration: 728s

This is a monthly deep audit. The crawler performed a full-site scan including

Lighthouse performance, axe-core accessibility (WCAG 2.2 AA), cross-browser compatibility,

security headers, schema markup validation, and SEO best-practice checks.

Because this site is not a repository we control, Apex Sentinel **cannot automatically

apply fixes** — instead, each finding below includes an AI-generated plain-English

explanation + step-by-step recommended fix you can hand to a developer or execute

in your CMS directly.

Executive Summary

Overall grade: F

DIMENSION COUNT MEANING

Pages crawled 18 Full sitemap + linked pages

P0 (critical) 1 Site-down or compliance-breaking

P1 (urgent) 3 Significant revenue / SEO / UX impact

P2 (high) 25 Quality / ranking / trust degradation

https://litmospheres.com/


DIMENSION COUNT MEANING

P3 (medium) 74 Polish + optimization

"Do first" items 4 AI-flagged top priorities

Quick wins (< 30 min) 54 Fastest ROI items

Top 10 Actions (Ranked)

If you only have time for ten things this month, do these — in this order.

1. [P0] 🔴  DO FIRST Sensitive artifact exposed: /wp-login.php — _An unauthorized login compromise could

allow attackers to inject malware, deface your site, steal customer data including age-verification records, or

take your dispensary offline—directly threatening sales and compliance._

Page: https://litmospheres.com/wp-login.php

Effort: Moderate (1-3 hours)

1. [P1] 🔴  DO FIRST 1 mixed-content references (http://) — _Mixed-content warnings erode customer trust,

especially critical in cannabis retail where compliance and legitimacy are already under scrutiny. It may also

trigger browser security warnings that discourage purchases._

Page: https://litmospheres.com/

Effort: Quick win (< 30 min)

1. [P1] 🔴  DO FIRST A11y: ARIA dialog and alertdialog nodes should have an accessible name — _Screen

reader users—including those with visual disabilities—cannot navigate your age gate, effectively locking

them out of your site and exposing you to ADA/AODA compliance risk._

Page: https://litmospheres.com/

Effort: Quick win (< 30 min)

1. [P1] 🔴  DO FIRST Journey failed: default: homepage → age gate → menu visible — _Visitors cannot

proceed past the age gate or access your menu, preventing sales and creating a broken user experience

that damages trust and compliance appearance._

Page: https://litmospheres.com/

Effort: Moderate (1-3 hours)

1. [P2] 🟠  HIGH 7 image(s) missing alt text — _Visitors using screen readers get a worse experience,

potentially leaving your site; Google also ranks pages with complete alt text slightly higher, affecting your

visibility in search results._

Page: https://litmospheres.com/services/

Effort: Quick win (< 30 min)

1. [P2] 🟠  HIGH 5 image(s) missing alt text — _Missing alt text on your contact page hurts SEO ranking for

image search, reduces accessibility for customers using assistive technology, and may expose you to
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accessibility compliance complaints under ADA/AODA standards._

Page: https://litmospheres.com/contact/

Effort: Quick win (< 30 min)

1. [P2] 🟠  HIGH 7 image(s) missing alt text — _Missing alt text hurts your search ranking for image-related

queries (like 'cannabis dispensary team' or 'local weed shop staff') and excludes customers using assistive

technology — a legal accessibility concern for cannabis retailers in many jurisdictions._

Page: https://litmospheres.com/about-us/

Effort: Quick win (< 30 min)

1. [P2] 🟠  HIGH 12 image(s) missing alt text — _Visitors using screen readers cannot understand product

photos or location visuals, lowering trust and accessibility compliance risk; Google also ranks pages with

properly described images higher, especially important for cannabis retail where product imagery drives

conversions._

Page: https://litmospheres.com/dispensary-schodack-ny/

Effort: Moderate (1-3 hours)

1. [P2] 🟠  HIGH 12 image(s) missing alt text — _You're losing potential customers who use screen readers,

and search engines can't index your product photos, strains, or store imagery—reducing your local search

visibility for 'cannabis near me' queries._

Page: https://litmospheres.com/dispensary-near-east-greenbush-ny/

Effort: Moderate (1-3 hours)

1. [P2] 🟠  HIGH 11 image(s) missing alt text — _Missing alt text blocks accessibility compliance (risking legal

issues in some jurisdictions) and costs you organic traffic, especially from image search where cannabis

lifestyle and product imagery drive discovery._

Page: https://litmospheres.com/?elementor_library=default-kit

Effort: Quick win (< 30 min)

Findings by Severity

P0 — 1 finding

1. Sensitive artifact exposed: /wp-login.php

Severity: P0 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: security

Page URL: https://litmospheres.com/wp-login.php

Rule: tier5.exposed.artifact

What it means (plain English)
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Your WordPress login page is publicly accessible at /wp-login.php. This is a common attack target where

hackers try to break into your site by guessing usernames and passwords. While WordPress is installed on your

server, exposing this path makes it easier for automated attacks to find and attempt to breach your admin area.

Why it matters for your business: An unauthorized login compromise could allow attackers to inject malware,

deface your site, steal customer data including age-verification records, or take your dispensary offline—

directly threatening sales and compliance.

Technical root cause: WordPress login pages are enabled by default. Your server is not blocking or redirecting

this sensitive path at the edge (CDN/firewall level), leaving it openly accessible to the internet.

Recommended fix — step by step

1. Log in to your WordPress admin dashboard, then go to Settings → General and verify your 'Site URL' and

'WordPress Address' are both https://litmospheres.com (not /wp-admin or /wp-login).

2. Install the 'Wordfence Security' plugin (free tier): Dashboard → Plugins → Add New → search 'Wordfence' →

Install and Activate.

3. In Wordfence, go to Firewall → Firewall Options → scroll to 'Disable XML-RPC' and enable it.

4. In Wordfence, go to Login Security → click 'Rename the WordPress login page' → choose a custom slug

(e.g., /secure-admin-access/) and save.

5. Contact your hosting provider and request they implement a WAF (Web Application Firewall) rule to rate-

limit or block repeated access attempts to /wp-login.php.

6. If you have a CDN (Cloudflare, Bunny, etc.), log in and create a Page Rule to block the path: set URL pattern

to litmospheres.com/wp-login.php → Block.

P1 — 3 findings

1. 1 mixed-content references (http://)

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: security

Page URL: https://litmospheres.com/

Rule: tier5.mixed-content

What it means (plain English)

Your website is served over HTTPS (secure), but it's trying to load a resource from an HTTP URL (insecure).

Modern browsers block or warn about this, which can degrade trust and break functionality. In this case, it's a

reference to http://oasas.ny.gov/HOPELine — likely a link to New York's addiction helpline resource.

Why it matters for your business: Mixed-content warnings erode customer trust, especially critical in

cannabis retail where compliance and legitimacy are already under scrutiny. It may also trigger browser security

warnings that discourage purchases.

Technical root cause: A link or resource embed in your page points to the HTTP version of a domain instead of

HTTPS. The external domain (oasas.ny.gov) may not support HTTPS, or the link was simply copy-pasted with

http:// instead of https://.

Recommended fix — step by step
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1. Visit https://litmospheres.com/ in your browser and use Developer Tools (F12 → Console) to confirm the

mixed-content warning and identify the exact HTML element.

2. Locate the link to http://oasas.ny.gov/HOPELine in your site's HTML or content management system (likely in

a footer, compliance section, or modal).

3. Change the link from http://oasas.ny.gov/HOPELine to https://oasas.ny.gov/HOPELine and test in browser to

confirm the warning is gone.

4. If the external domain does not support HTTPS, wrap the link in a data URI or iframe workaround — contact

your hosting provider for alternatives if this persists.

5. Search your entire site codebase (Ctrl+F or grep) for any other instances of 'http://' URLs and repeat the fix.

2. A11y: ARIA dialog and alertdialog nodes should have an accessible name

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: compliance

Page URL: https://litmospheres.com/

Rule: tier9.a11y.aria-dialog-name

What it means (plain English)

Your age-gate dialog (the overlay that appears when visitors first land on your site) doesn't have a label that

screen readers can announce. Screen reader users don't know what the dialog is for or how to interact with it.

This is a critical accessibility barrier that may prevent some users from even entering your site.

Why it matters for your business: Screen reader users—including those with visual disabilities—cannot

navigate your age gate, effectively locking them out of your site and exposing you to ADA/AODA compliance

risk.

Technical root cause: The dialog element with id 'baag3-gate' has role='dialog' and aria-modal='true' but

lacks an aria-label, aria-labelledby, or title attribute to announce its purpose to assistive technology.

Recommended fix — step by step

1. Inspect the #baag3-gate element in your browser DevTools (F12 → Elements tab, search for 'baag3-gate')

2. Add aria-label='Age Verification' directly to the div: <div id="baag3-gate" ... aria-label="Age Verification"

role="dialog" aria-modal="true">

3. If your age gate has a visible heading (e.g., 'You must be 21+'), use aria-labelledby instead: add id='age-

heading' to that heading, then add aria-labelledby='age-heading' to the dialog div

4. Test with a screen reader (NVDA on Windows is free; VoiceOver on Mac is built-in) to confirm the dialog is

announced when it appears

5. If you use a third-party age-gate plugin (baag3 appears to be the vendor), check their latest docs for

accessibility settings or upgrade to the newest version

3. Journey failed: default: homepage → age gate → menu visible

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: compliance

Page URL: https://litmospheres.com/

Rule: tier10.journey.failed
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What it means (plain English)

Your site is trying to load a JavaScript module (a .js file imported with type="module" ) but the server is
sending back an HTML page instead. This breaks the age gate and menu functionality on the homepage.

Modern browsers strictly enforce this check for security reasons, so the module refuses to load and the page

becomes non-functional.

Why it matters for your business: Visitors cannot proceed past the age gate or access your menu, preventing

sales and creating a broken user experience that damages trust and compliance appearance.

Technical root cause: A JavaScript import statement (likely import { ... } from
'path/to/file.js' ) is pointing to a URL that returns an HTML 404 error page instead of the actual

JavaScript file. This usually happens when a script path is wrong, the file is in the wrong location, or the server

isn't configured to serve .js files with the correct MIME type (application/javascript).

Recommended fix — step by step

1. Open your browser's Developer Tools (F12 or Cmd+Option+I), go to the Console tab, and note the exact URL

mentioned in the error message.

2. Visit that URL directly in your browser address bar to confirm it returns HTML instead of JavaScript code.

3. Check your website files: the .js file likely exists but is in a different folder than the import statement expects

(e.g., /js/module.js  vs /assets/js/module.js ).

4. If using a CMS or website builder (WordPress, Webflow, etc.), verify that static JavaScript files are uploaded

to the correct directory and not blocked by security plugins.

5. If hosting on a custom server, confirm the web server (Apache, Nginx) is configured to serve .js  files

with Content-Type: application/javascript  header.

6. Once the path is corrected, clear your browser cache (Ctrl+Shift+Del / Cmd+Shift+Del) and reload the

homepage to test.

7. Rerun your automated journey test to confirm the console error is gone and the age gate + menu load

successfully.

P2 — 25 findings

1. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://litmospheres.com/services/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Seven images on your Services page don't have alt text — short descriptive labels that explain what the image

shows. Screen readers used by visually impaired customers can't describe these images, and search engines

can't index them properly. This creates a barrier for accessibility and loses a small but real SEO signal.

Why it matters for your business: Visitors using screen readers get a worse experience, potentially leaving

your site; Google also ranks pages with complete alt text slightly higher, affecting your visibility in search

results.

https://litmospheres.com/services/


Technical root cause: Images were likely added to the HTML or CMS without the alt attribute populated, or the

alt attribute was left blank.

Recommended fix — step by step

1. Visit https://litmospheres.com/services/ and open browser DevTools (F12 → Inspector tab) to identify each

image; look for <img> tags with missing or empty alt="" attributes.

2. For each of the 7 images, write a concise alt text (1–10 words) that describes what the image shows — e.g.,

'Cannabis pre-rolls in glass jar' or 'Budtender helping customer at counter'.

3. If your site runs on WordPress: install Yoast SEO → go to Media Library → click each image → fill in the 'Alt

Text' field → Save.

4. If your site is custom-coded HTML/CMS: add or edit the alt attribute in each <img> tag directly (e.g., <img

src="product.jpg" alt="Cannabis flower display">).

5. After updating, re-check the Services page using the WAVE accessibility tool (https://wave.webaim.org/) to

confirm all images now have alt text.

6. Test with a screen reader simulator (NVDA on Windows or VoiceOver on Mac) to confirm the alt text reads

naturally to users.

2. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://litmospheres.com/contact/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Your contact page has 5 out of 6 images missing alt text — short descriptions that explain what each image

shows. Search engines can't read images, so they rely on alt text to understand your content. Screen reader

users (people with vision loss) also depend on alt text to know what's on the page.

Why it matters for your business: Missing alt text on your contact page hurts SEO ranking for image search,

reduces accessibility for customers using assistive technology, and may expose you to accessibility compliance

complaints under ADA/AODA standards.

Technical root cause: Images in HTML are missing the 'alt' attribute, or the attribute is empty. This is typically

a template or CMS oversight during page creation.

Recommended fix — step by step

1. Open https://litmospheres.com/contact/ in your browser and identify all 5 images visually (product photos,

logos, decorative elements, etc.).

2. Right-click each image → Inspect (or press F12, find the <img> tag in DevTools) and note whether it has

alt="" or no alt attribute at all.

3. For each image, write a short, descriptive alt text (5–10 words): e.g., 'Cannabis flower product display' or

'Litmosphere team photo'.

4. If your site uses WordPress: install Yoast SEO (free) → go to each image in Media Library → fill 'Alt Text' field

→ save.

5. If your site is custom HTML: edit the HTML source, add alt="description" inside each <img> tag, e.g. <img

src="flower.jpg" alt="Cannabis flower product display">.
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6. If using a page builder (Elementor, Divi, etc.): click each image block → find Image Settings panel → fill Alt

Text field.

7. After updating, re-run an accessibility checker (e.g., axe DevTools browser extension) to confirm all 5

images now have alt text.

8. Document the alt text additions in your content management log for future compliance audits.

3. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://litmospheres.com/about-us/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Seven images on your About Us page don't have alt text — descriptive text that explains what each image

shows. Search engines and screen readers (used by people with vision impairments) can't understand

unlabeled images, so they get skipped entirely. This means lost SEO value and a worse experience for

accessible browsing.

Why it matters for your business: Missing alt text hurts your search ranking for image-related queries (like

'cannabis dispensary team' or 'local weed shop staff') and excludes customers using assistive technology — a

legal accessibility concern for cannabis retailers in many jurisdictions.

Technical root cause: Images were uploaded to the page without alt attribute metadata. Most CMS platforms

provide an 'alt text' field during image upload that was left blank.

Recommended fix — step by step

1. Log into your CMS admin and navigate to the About Us page editor.

2. Click each of the 7 images individually to open its properties/settings panel.

3. In the 'Alt Text' or 'Alternative Text' field, write 1–2 sentences describing what the image shows (e.g.,

'Litmosphere team members smiling in the retail space' or 'Cannabis product display case').

4. For any team photos, include the person's name and role if visible (e.g., 'Sarah Chen, Store Manager,

standing behind the checkout counter').

5. Save and republish the page.

6. Run a quick re-check using a free tool like WAVE (wave.webaim.org) or axe DevTools browser extension on

that same URL to confirm all 8 images now have alt text.

4. 12 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://litmospheres.com/dispensary-schodack-ny/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

https://litmospheres.com/about-us/
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Twelve images on your Schodack dispensary page are missing alt text — descriptive labels that screen readers

announce to visually impaired visitors and that search engines read to understand image content. This creates a

barrier for accessibility and reduces the page's search visibility for image-based queries.

Why it matters for your business: Visitors using screen readers cannot understand product photos or location

visuals, lowering trust and accessibility compliance risk; Google also ranks pages with properly described

images higher, especially important for cannabis retail where product imagery drives conversions.

Technical root cause: Images were added to the page without the alt attribute populated. This is often due to

manual image uploads without a content management workflow that enforces alt text entry.

Recommended fix — step by step

1. Identify all 12 affected images on the Schodack page by opening DevTools (F12 → Inspector) and searching

for <img> tags without alt= attributes.

2. For each image, write a concise alt text (5–10 words) describing what's shown — e.g., 'Assorted cannabis

flower products on wooden shelf' or 'Litmosphere Schodack storefront entrance'.

3. If using a CMS (WordPress, Shopify, etc.), go to the Media Library or page editor, find each image, and fill in

the 'Alt Text' field before saving.

4. If editing HTML directly, add alt="[description]" to each <img> tag; for decorative images only, use alt=""

(empty string).

5. Run an accessibility scan again (using WAVE, Axe DevTools, or Lighthouse in DevTools) to confirm all images

now have alt text.

6. For product images, include product name or type in the alt text when possible (e.g., 'Northern Lights strain,

3.5g' helps both accessibility and SEO).

5. 12 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://litmospheres.com/dispensary-near-east-greenbush-ny/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Twelve images on your East Greenbush dispensary page don't have alt text—descriptive labels that screen

readers announce to blind and low-vision visitors, and that search engines use to understand image content.

This creates a barrier for accessibility and misses an SEO opportunity, since Google can't index what those

images contain.

Why it matters for your business: You're losing potential customers who use screen readers, and search

engines can't index your product photos, strains, or store imagery—reducing your local search visibility for

'cannabis near me' queries.

Technical root cause: Images were inserted into the page without the HTML alt  attribute populated, likely

during content management or bulk image uploads where alt text wasn't filled in.

Recommended fix — step by step

1. Log into your CMS (WordPress, Shopify, or custom backend) and navigate to the East Greenbush page.

2. Inspect each of the 12 images and add concise, descriptive alt text (e.g., 'Purple Haze cannabis strain buds'

or 'Litmosphere dispensary storefront in East Greenbush'—aim for 5–10 words per image).

https://litmospheres.com/dispensary-near-east-greenbush-ny/


3. Prioritize product/strain photos and the store location image; decorative images can use empty alt text

(alt='').

4. If using WordPress with an image plugin (e.g., Smush, Yoast), enable automatic alt-text suggestions as a

fallback, but manually review and edit each one.

5. Test the page with a free tool like WAVE (wave.webaim.org) to confirm all 12 images now show alt text.

6. Repeat this audit on similar pages (product pages, other location pages) to catch the pattern site-wide.

6. 11 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://litmospheres.com/?elementor_library=default-kit

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Eleven images on your site are missing alt text — a text description that explains what each image shows.

Screen readers used by visually impaired customers can't describe these images, and search engines can't

understand what they depict, which reduces your visibility in Google Images and general search results.

Why it matters for your business: Missing alt text blocks accessibility compliance (risking legal issues in some

jurisdictions) and costs you organic traffic, especially from image search where cannabis lifestyle and product

imagery drive discovery.

Technical root cause: Images were added to the site without filling in the alt text field during upload or page

editing. Most likely, the Elementor page builder's image blocks were inserted without alt attributes populated.

Recommended fix — step by step

1. Log into the WordPress admin → Pages/Posts and open the page containing the affected images (likely your

homepage or product showcase).

2. Switch to Elementor edit mode; locate each image widget in the canvas.

3. Click each image block → in the right panel, find the 'Alt Text' or 'Accessibility' section and write a concise,

descriptive alt text (e.g., 'Purple cannabis flower bud close-up' or 'Litmosphere product packaging shot').

4. For product images, include product name + key visual detail; for lifestyle shots, describe the scene and any

brand elements visible.

5. Save and publish the changes.

6. Run a free accessibility checker (WAVE browser extension or axe DevTools) on the published page to

confirm all 11 images now have alt text.

7. Mobile perf measurement failed

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: performance

Page URL: https://litmospheres.com/

Rule: tier3.perf.mobile-fail

What it means (plain English)
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Our automated performance testing tool timed out while trying to load your homepage on a mobile connection

— it waited 60 seconds and never received a signal that the page had finished loading all resources. This

suggests either the homepage is taking extremely long to load, or something is blocking the page from

signaling it's ready (such as a script that never completes or a third-party service that's stalled).

Why it matters for your business: Customers visiting on mobile — likely a significant portion of dispensary

traffic — may experience a blank or slow-loading page, leading to abandonment before they can browse

products or check your hours; search engines also penalize slow mobile sites in rankings.

Technical root cause: The page is either genuinely slow to load (large unoptimized images, render-blocking

scripts, or heavy third-party embeds), or a JavaScript or tracking service is hung and preventing the browser

from finishing its load cycle.

Recommended fix — step by step

1. Open Chrome DevTools on a mobile device (or Chrome's device emulation) → Network tab → reload the

homepage and check which requests take longest or fail; note any red (failed) requests and any that hang

past 10 seconds.

2. Check the Console tab in DevTools for JavaScript errors or warnings that might indicate a stuck script or

failed API call.

3. Review your third-party integrations: if you use a chatbot, analytics, or age-gate provider, temporarily

disable it and reload to see if that resolves the timeout.

4. If you use a page-builder (Wix, Squarespace, Shopify), check their performance insights dashboard or

contact their support to flag slow homepage load.

5. Compress all hero images and product photos to under 200 KB each using an online tool (e.g., tinypng.com

or squoosh.app) and re-upload.

6. Once the page loads reliably, run it through Google PageSpeed Insights (https://pagespeed.web.dev/) to get

detailed mobile performance recommendations.

8. Missing security header: strict-transport-security

Severity: P2 | Priority: 🟠  HIGH

Effort: Vendor escalation (host/registrar/etc.)

Business category: security

Page URL: https://litmospheres.com/

Rule: tier5.header.strict-transport-security

What it means (plain English)

Your site is missing the Strict-Transport-Security (HSTS) header, which tells browsers to always use HTTPS

when connecting to your domain. Without it, visitors could be vulnerable to man-in-the-middle attacks if they

accidentally visit via HTTP first. This is especially critical for a cannabis retailer handling age verification and

customer data.

Why it matters for your business: Missing HSTS weakens customer trust and data security, and can

negatively impact search rankings—Google favors sites with strong security headers.

Technical root cause: The server (hosted on Bluehost via Cloudflare) is not configured to send the Strict-

Transport-Security header in HTTP responses. This is a server-side configuration issue, not a code problem.

Recommended fix — step by step

1. Log into your Bluehost control panel (cPanel) and navigate to the 'SSL/TLS Status' section to confirm HTTPS

is active on your domain.

https://pagespeed.web.dev/)
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2. If you manage Cloudflare directly, go to cloudflare.com → your domain → Security → HTTP Headers and

check if HSTS is already set; if not, enable 'HSTS' with max-age set to 31536000 (1 year).

3. If Cloudflare is managed by Bluehost, contact Bluehost support and request they enable HSTS header with

max-age=31536000; provide them this exact header: Strict-Transport-Security: max-age=31536000;

includeSubDomains; preload.

4. After enabling, wait 2–4 hours for propagation, then verify at securityheaders.com by entering

https://litmospheres.com and confirming the 'A' grade includes HSTS in the report.

9. Missing security header: x-frame-options

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: security

Page URL: https://litmospheres.com/

Rule: tier5.header.x-frame-options

What it means (plain English)

Your site is missing the X-Frame-Options security header, which tells browsers whether your pages can be

embedded inside frames or iframes on other websites. Without this header, malicious sites could embed your

content in a hidden frame to trick users or steal data — a technique called clickjacking. This is a standard

security control that takes minutes to add.

Why it matters for your business: A clickjacking attack could trick customers into unknowingly authorizing

transactions, sharing payment info, or completing unintended actions while they think they're interacting with

your dispensary site, directly exposing you to liability and customer trust damage.

Technical root cause: The X-Frame-Options header is not being set in your server or WordPress configuration.

Your site runs on WordPress (evidenced by wp-json links in headers) hosted on Bluehost (via Cloudflare), and

the header needs to be added either at the WordPress level or via your hosting control panel.

Recommended fix — step by step

1. Log into your Bluehost cPanel (typically cPanel.bluehost.com with your Bluehost login credentials).

2. Locate 'ModSecurity Tools' or 'Apache Configuration' — if available, add the header there; otherwise

proceed to WordPress.

3. In WordPress admin (litmospheres.com/wp-admin), install the 'Security Headers' plugin (search for 'security

headers' in Plugins > Add New).

4. Activate the plugin and navigate to its settings page.

5. Set X-Frame-Options to 'DENY' or 'SAMEORIGIN' (DENY is stricter; SAMEORIGIN allows framing only from

your own domain).

6. Save and test by visiting https://securityheaders.com and pasting your URL to confirm the header now

appears.

7. If the plugin option doesn't work, contact Bluehost support and ask them to add 'Header set X-Frame-

Options "DENY"' to your .htaccess file or Apache config.

10. Missing security header: content-security-policy

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: security

https://litmospheres.com/
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Page URL: https://litmospheres.com/

Rule: tier5.header.content-security-policy

What it means (plain English)

Your site is missing a Content Security Policy (CSP) header — a security rule that tells browsers which external

resources (scripts, images, fonts) are allowed to load. Without it, attackers could inject malicious code more

easily. This is a standard security best practice for all websites, especially those handling customer data.

Why it matters for your business: A missing CSP weakens your site's defenses against code injection attacks,

which could compromise customer data, payment information, or your reputation — critical for a retail business

handling transactions.

Technical root cause: The HTTP response headers from your server do not include a Content-Security-Policy

directive. Your site is hosted on Bluehost (via Cloudflare), and CSP must be set either in your WordPress site

settings, .htaccess file, or via your hosting control panel.

Recommended fix — step by step

1. Log in to your Bluehost cPanel → Files → File Manager → navigate to your site root → open or create

.htaccess file

2. Add this line: Header set Content-Security-Policy "default-src 'self'; script-src 'self' 'unsafe-inline'

cdn.jsdelivr.net cloudflare.com; style-src 'self' 'unsafe-inline'; img-src 'self' data: https:; font-src 'self'

fonts.googleapis.com; connect-src 'self'; frame-src 'self'"

3. Save and test by visiting your homepage, then use a browser DevTools (F12 → Network tab → click

homepage request → Headers) to confirm the Content-Security-Policy header appears

4. Alternatively, if you prefer to avoid .htaccess: in WordPress admin, install the plugin 'Headers and Footers'

by WPCode, go to Snippets → Add Snippet, paste the CSP header code (formatted as PHP header() call),

mark it for Site-wide Header, and activate

5. If you use a security plugin like Wordfence, log in to Wordfence → Firewall → Firewall Rules → enable

'Content Security Policy' option if available, or escalate to Bluehost support to enable CSP at the server level

11. Cookie missing Secure flag

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: security

Page URL: https://litmospheres.com/

Rule: tier5.cookie.no-secure

What it means (plain English)

Your website sets a cookie (nfd-enable-cf-opt) without the Secure flag. This flag tells browsers to only send the

cookie over encrypted HTTPS connections, not unencrypted HTTP. Without it, if a visitor's connection is

downgraded or intercepted, that cookie data could be exposed to attackers.

Why it matters for your business: A compromised cookie could allow attackers to impersonate customers,

access their accounts, or tamper with their orders — damaging trust and exposing you to payment fraud and

compliance violations.

Technical root cause: The Set-Cookie HTTP response header for nfd-enable-cf-opt is missing the Secure

attribute. This is typically set by your hosting/CDN layer (Cloudflare appears involved) or server-side code that

generates cookies.

Recommended fix — step by step
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1. Log into your Cloudflare dashboard (if you use it) → Rules → Transform Rules → check for any Cookie rules

that set nfd-enable-cf-opt, and add Secure flag if present

2. Contact your hosting provider and confirm all Set-Cookie headers in their configuration include Secure; if

they use Cloudflare, ask them to enable 'Secure Cookies' in CF dashboard under Security

3. If you manage server-side code (PHP, Node, etc.), locate any code that sets nfd-enable-cf-opt and append;

Secure to the Set-Cookie header

4. Test the fix using Chrome DevTools (F12 → Application → Cookies) — re-visit the site over HTTPS and verify

nfd-enable-cf-opt shows 'Secure' ✓ in the Secure column

12. No DMARC policy published

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: security

Page URL: https://litmospheres.com/

Rule: tier5.fortress.dmarc-missing

What it means (plain English)

Your domain has a valid SPF record (which helps prevent email spoofing) but is missing a DMARC policy—a set

of instructions that tell email providers how to handle emails claiming to be from your domain. Without DMARC,

bad actors can more easily send fake emails that appear to come from Litmosphere, damaging trust with

customers and potentially landing legitimate emails in spam folders.

Why it matters for your business: Missing DMARC increases the risk that your marketing emails, order

confirmations, and customer communications land in spam or are spoofed by scammers, eroding customer trust

and reducing engagement on time-sensitive compliance or promotional messages.

Technical root cause: DMARC is published as a DNS text record at _dmarc.litmospheres.com; this record does

not exist. Many sites skip DMARC initially because it requires DNS changes and can appear technical, but it is a

standard email authentication layer that takes minimal effort to deploy.

Recommended fix — step by step

1. Log into your DNS host (e.g., GoDaddy, Namecheap, Route 53) and navigate to your DNS records for

litmospheres.com.

2. Create a new TXT record with hostname '_dmarc' and value 'v=DMARC1; p=none; rua=mailto:dmarc-

reports@litmospheres.com' (p=none enables monitoring without rejecting mail).

3. Save the record and wait 15 minutes for propagation.

4. Visit mxtoolbox.com → DMARC lookup → enter litmospheres.com to verify the record is live.

5. Once monitoring is confirmed (in 5–7 days), request a summary of DMARC reports sent to the email you

specified to ensure no legitimate senders are failing.

6. If all checks pass, consider upgrading to 'p=quarantine' (move suspicious mail to spam) or 'p=reject' (block)

in 30 days, after confirming no critical partners are affected.

13. 57 tap targets under 44px at mobile-320

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://litmospheres.com/
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Rule: tier6.a11y.small-targets

What it means (plain English)

Your homepage has 57 buttons, links, and interactive elements that are smaller than 44×44 pixels when viewed

on a mobile phone at 320px width. This makes them hard to tap accurately—especially for customers with larger

fingers, tremors, or vision impairments. WCAG 2.5.5 is an accessibility standard that requires touch targets to

be at least 44×44 pixels.

Why it matters for your business: Small tap targets frustrate mobile shoppers (which likely include many

cannabis customers browsing on their phones), leading to cart abandonment, missed age-gate confirmations,

and reduced conversion rates. It also exposes you to accessibility complaints or legal risk.

Technical root cause: Interactive elements (buttons, links, product thumbnails, filters, or navigation items) are

likely styled with padding or font-size values too small, or are crowded together without adequate spacing.

Mobile-specific CSS may be missing or incorrectly calculated.

Recommended fix — step by step

1. Open your site in Chrome DevTools (F12 → Device Toolbar → set to 'Mobile 320'), then use the 'Inspect' tool

to hover over clickable elements and check their computed width/height in the Elements panel.

2. Identify which elements are under 44×44px (common culprits: close buttons, small category filters, social

icons in footer, quantity +/− buttons, product review stars).

3. For each undersized element, increase padding (e.g., CSS padding: 12px instead of 4px) to reach 44×44px

minimum, or add margin-right/margin-bottom spacing to separate crowded elements.

4. If the element is text-based (link or button), increase font-size to 16px+ and add padding to achieve 44px

height/width.

5. For icon buttons (cart, menu), ensure the clickable area (using ::before or padding) extends to 44×44px

even if the icon itself is smaller.

6. Test the fix: reload DevTools Device Toolbar, re-inspect, confirm all interactive elements now show

width/height ≥ 44px.

7. Use an automated accessibility checker (axe DevTools browser extension, free) to re-scan and confirm

target size violations drop to near-zero.

14. 56 tap targets under 44px at mobile-375

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://litmospheres.com/

Rule: tier6.a11y.small-targets

What it means (plain English)

Your site has 56 interactive buttons and links that are smaller than 44×44 pixels when viewed on a mobile

phone (375px width). This makes them hard to tap accurately, especially for people with limited motor control

or larger fingers. It's a recognized accessibility standard (WCAG 2.5.5) that most tap targets should be at least

44×44 pixels.

Why it matters for your business: Customers on mobile devices — your primary traffic source for a cannabis

retailer — will struggle to tap menu items, product filters, and checkout buttons, leading to cart abandonment

and lost sales. It also signals poor UX to search engines and accessibility-conscious visitors.
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Technical root cause: The site's CSS or HTML uses small font sizes and padding on buttons, links, and

interactive elements. Mobile viewport scaling may also be compressing clickable areas. Navigation menus,

product page links, or filter buttons are likely not padded with enough whitespace around their text.

Recommended fix — step by step

1. Audit your mobile CSS: open DevTools (F12) → toggle device toolbar to 375px width → inspect each small

button/link and note the computed width/height.

2. Increase padding on all buttons to at least 8px (top/bottom) and 12px (left/right) so the clickable area

reaches 44×44px minimum.

3. Expand link font sizes to 16px or larger on mobile, or increase line-height to 1.5+ to naturally enlarge touch

targets.

4. Add min-width and min-height properties: e.g., button { min-width: 44px; min-height:
44px; }  in your CSS.

5. Test navigation menus, product category links, filter toggles, and 'Add to Cart' buttons at 375px viewport to

confirm all exceed 44×44px.

6. Run a second DevTools audit (Lighthouse → Accessibility) to verify the fix; target 0 failures under 'Tap

targets not sized appropriately'.

15. 57 tap targets under 44px at mobile-414

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://litmospheres.com/

Rule: tier6.a11y.small-targets

What it means (plain English)

Your website has 57 interactive buttons, links, and input fields that are smaller than 44×44 pixels on mobile

phones. This makes them hard to tap accurately—especially for customers with larger fingers, vision

impairments, or motor control challenges. Apple and Google both recommend 44×44 as the minimum touch

target size.

Why it matters for your business: Customers struggle to complete purchases, sign up for loyalty programs, or

navigate your menu on mobile devices, leading to cart abandonment and lost sales.

Technical root cause: Interactive elements were likely sized for desktop viewing (often 32px or smaller)

without scaling up for touch interfaces, or CSS padding/margins are insufficient around clickable areas.

Recommended fix — step by step

1. Open browser DevTools (F12) → go to mobile view (414px width) → use the Inspect tool to identify the

smallest buttons/links (look for width/height < 44px in the Styles panel)

2. For each undersized element, increase the CSS padding around it to reach at least 44×44px total (e.g.,

padding: 10px 12px for a 24px text button makes it ~44px tall)

3. If padding alone won't work without breaking layout, increase the font-size or line-height of text inside

buttons (larger text = larger tap target)

4. Test form inputs (search boxes, radio buttons, checkboxes) — ensure they are also 44×44px minimum; use -

webkit-appearance: none and custom sizing if the browser default is too small

5. Use Firefox or Chrome DevTools' accessibility audit feature (Lighthouse → Accessibility tab) to re-run the

test and confirm all targets now pass
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6. On mobile, avoid stacking buttons/links too close together — ensure at least 8px spacing between adjacent

tap targets to prevent mis-taps

16. 25 tap targets under 44px at tablet-768

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://litmospheres.com/

Rule: tier6.a11y.small-targets

What it means (plain English)

Your website has 25 buttons, links, and interactive elements that are smaller than 44x44 pixels when viewed on

tablets. This makes them hard to tap accurately—especially for people with motor control challenges, older

users, or anyone on a small screen. WCAG 2.5.5 is an accessibility standard that requires tap targets to be at

least 44×44 pixels to be reliably clickable.

Why it matters for your business: Small tap targets create friction for mobile and tablet customers trying to

navigate your menu, add products to cart, or access age verification—directly reducing conversion and risking

compliance complaints or legal exposure under accessibility laws.

Technical root cause: Interactive elements are likely styled with padding or dimensions below 44px, or are

closely spaced together without adequate padding. This often happens when desktop designs (which tolerate

smaller clicks) are directly shrunk for mobile/tablet without adjustment.

Recommended fix — step by step

1. Use browser DevTools (right-click → Inspect) to identify the 25 small targets; note their selectors (e.g.,

'.btn-small', '.nav-link')

2. Open your CSS file and increase padding on buttons/links: change 'padding: 8px 12px' to at least 'padding:

12px 16px' to reach 44×44

3. Add 'min-width: 44px; min-height: 44px;' to all interactive elements (buttons, links, form inputs)

4. For closely-spaced links (e.g., footer links), increase margin-bottom to at least 8px to ensure 44px vertical

spacing

5. Test on a tablet (or use Chrome DevTools → Responsive Design Mode, set width 768px) and verify all

buttons are easy to tap

6. Re-run accessibility audit to confirm count drops to 0

17. Lighthouse perf (mobile): 58/100

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: revenue

Page URL: https://litmospheres.com/

Rule: tier8.lighthouse.perf-mobile

What it means (plain English)

Your mobile site takes over 31 seconds for the largest visual element (like a hero image or product photo) to

appear. That's roughly 6× slower than Google's recommended 2.5 seconds. Most visitors will bounce or leave

before seeing your menu, products, or age-gate content.
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Why it matters for your business: Slow mobile load times cost cannabis retailers direct revenue: customers

abandon carts, search engines rank you lower, and you miss age-gated visitor conversions during peak

browsing times (mobile traffic dominates retail).

Technical root cause: The LCP (Largest Contentful Paint) metric of 31.5 seconds indicates oversized or

unoptimized images, render-blocking JavaScript, or missing lazy-loading directives on the critical path.

Common culprits: hero images not served in next-gen formats (WebP), slow third-party scripts (analytics, ads),

or unminified CSS/JS.

Recommended fix — step by step

1. Download the Lighthouse HTML report from the path above; open it in a browser and expand the

'Opportunities' section to see which assets (images, scripts) are the slowest.

2. Convert all hero and product images to WebP format using a tool like Squoosh (squoosh.app) or

ImageMagick; replace src in HTML or CMS with WebP and JPEG fallback.

3. Enable lazy-loading on below-fold images: add loading='lazy'  attribute to all <img>  tags that

aren't above the fold.

4. Defer non-critical JavaScript: audit Google Tag Manager, analytics trackers, and chatbot scripts; move them

to the footer or mark them async  or defer  in HTML.

5. Minify CSS and JavaScript using your hosting provider's built-in tools or free online tools (minifycode.com);

replace unminified files in production.

6. Enable GZIP compression on your server (ask your hosting provider to confirm it's active for .js and .css

files).

7. Test mobile performance again using PageSpeed Insights (pagespeed.web.dev); target LCP under 2.5

seconds before re-auditing.

18. A11y: Heading levels should only increase by one (×2)

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://litmospheres.com/

Rule: tier9.a11y.heading-order

What it means (plain English)

Your homepage uses heading level 5 (h5) tags as primary section headers without proper hierarchy. Screen

readers and search engines expect headings to follow a logical order—typically starting with h1, then h2, h3, and

so on. Skipping directly to h5 confuses assistive technology and weakens the semantic structure of your page.

Why it matters for your business: Visitors using screen readers (including many with visual impairments, a

significant portion of online traffic) cannot navigate your site's structure effectively, reducing accessibility and

potentially limiting conversions. Search engines also use heading hierarchy to understand page topic relevance.

Technical root cause: The Elementor page builder is outputting h5 tags for what should be primary headings.

This typically happens when template or theme defaults are set to h5, or when headings are styled to look small

visually while remaining semantically as h5.

Recommended fix — step by step

1. Log into your WordPress admin → go to the page editor (or Elementor if you have the Elementor plugin

installed)
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2. Select the first heading widget that contains 'Welcome to' → in the Elementor panel on the right, look for

'HTML Tag' or 'Heading' dropdown and change it from H5 to H1

3. Select the second heading 'A New Kind of Cannabis Experience...' → change its HTML Tag from H5 to H2

4. Verify no h1 tag exists elsewhere on the homepage (WordPress typically auto-generates one from the site

title; you may have two h1s, which is also an issue — if so, remove or demote the auto-generated one to h2)

5. Save the page and run the accessibility audit again to confirm the heading order is now H1 → H2 → other

content headings in logical sequence

6. If you do not see an 'HTML Tag' option in Elementor, upgrade Elementor to the latest version or contact

Elementor support — this is a core feature

19. 11 image(s) missing alt text

Severity: P2

Page URL: https://litmospheres.com/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

20. 9 image(s) missing alt text

Severity: P2

Page URL: https://litmospheres.com/education-community/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

21. 12 image(s) missing alt text

Severity: P2

Page URL: https://litmospheres.com/cannabis-dispensary-castleton-on-hudson-ny/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

22. 11 image(s) missing alt text

Severity: P2

Page URL: https://litmospheres.com/?elementor_library=insta

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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23. 11 image(s) missing alt text

Severity: P2

Page URL: https://litmospheres.com/?elementor_library=elementor-header-209

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

24. 11 image(s) missing alt text

Severity: P2

Page URL: https://litmospheres.com/?elementor_library=elementor-footer-215

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

25. Missing core schema types: LocalBusiness

Severity: P2

Page URL: https://litmospheres.com/

Rule: tier4.schema.missing-core

Detail

Every site should emit Organization + LocalBusiness + WebSite JSON-LD.

P3 — 74 findings

1. 4 image(s) missing alt text

Severity: P3 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://litmospheres.com/castleton-on-hudson/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Four images on your Castleton-on-Hudson location page don't have alt text—descriptive labels that screen

readers use to tell visually impaired visitors what an image shows. This means those visitors get no information

from those images, and search engines can't understand what they depict either.

Why it matters for your business: Missing alt text reduces your SEO rankings for image searches and

location-specific queries, and excludes customers using assistive technology from seeing product photos or

dispensary visuals.
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Technical root cause: Images were uploaded to the page without alt attributes populated in the HTML img

tags, or the CMS failed to prompt for alt text during upload.

Recommended fix — step by step

1. Log in to your site admin and navigate to the Castleton-on-Hudson page in edit mode

2. Locate each image element on the page (look for <img> tags or image blocks in your editor)

3. For each of the 4 images, click edit/properties and fill in the 'Alt Text' or 'Alternative Text' field with a brief,

descriptive phrase (e.g., 'Litmosphere Castleton storefront' or 'Cannabis flower display')

4. Ensure alt text is 5–10 words, describes what's in the image, and includes relevant keywords naturally if

possible

5. Save each image change and publish the page

6. Run a free accessibility checker like WAVE (wave.webaim.org) on the live page to confirm all 5 images now

have alt text

2. robots.txt does not reference sitemap

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/robots.txt

Rule: tier2.robots.no-sitemap

What it means (plain English)

Your robots.txt file (the instruction file that tells search engines how to crawl your site) doesn't point to your

XML sitemap. A sitemap is a roadmap of all your pages that helps search engines find and index content faster,

especially new product pages or promotions you add.

Why it matters for your business: Without a sitemap reference, search engines may miss indexing new

strains, product updates, or location pages, reducing organic traffic and delaying visibility for new inventory or

promotions.

Technical root cause: The robots.txt file is missing a 'Sitemap:' directive. This directive is optional but

recommended; without it, search engines must discover your sitemap through other methods (like a meta tag),

which is slower and less reliable.

Recommended fix — step by step

1. Access your server via FTP/SFTP or your hosting control panel and locate the robots.txt file at the root of

your domain (e.g., /public_html/robots.txt)

2. Open robots.txt in a text editor and add this line at the end: Sitemap: https://litmospheres.com/sitemap.xml

(replace with your actual sitemap URL if it differs)

3. Verify you have a valid XML sitemap; if you don't, use a free tool like XML-Sitemaps.com to generate one for

your domain

4. Save and upload the updated robots.txt file

5. Test the change: visit https://litmospheres.com/robots.txt in your browser and confirm the Sitemap line

appears

6. Submit your sitemap directly to Google Search Console (Search Console → Sitemaps → paste your sitemap

URL) to ensure it's indexed

3. Title length 18 chars

https://litmospheres.com/robots.txt
https://litmospheres.com/sitemap.xml
https://litmospheres.com/robots.txt


Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/

Rule: tier2.meta.title-length

What it means (plain English)

Your homepage title tag (the text that appears in browser tabs and search results) is only 18 characters long.

Search engines prefer titles between 20–65 characters because longer, descriptive titles help people

understand what your page is about before clicking. A short title wastes an opportunity to include keywords and

context that could improve click-through rates from Google.

Why it matters for your business: Underutilized real estate in search results means fewer clicks from potential

customers searching for cannabis dispensaries or products in your area.

Technical root cause: The title tag in the page's HTML head section is minimal ('Home | Litmosphere'). It

should include descriptive keywords—like location, product category, or brand differentiator—to fill the 20–65

character window that Google displays.

Recommended fix — step by step

1. Open the homepage HTML file and locate the <title> tag in the <head> section.

2. Expand the title to 50–60 characters by adding location and primary keywords, e.g.: 'Cannabis Dispensary in

[City] | Litmosphere – Quality Products'

3. Verify the new title reads naturally in a browser tab and Google search results preview (use Google Search

Console → Performance → click your URL → see how it displays).

4. Test the same pattern on key landing pages: product category pages, about page, etc.

5. After publishing, monitor click-through rates in Google Search Console (go to Performance tab) over 2–4

weeks to confirm improvement.

4. Missing OpenGraph metadata

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/

Rule: tier2.meta.no-og

What it means (plain English)

When your website is shared on Facebook, Instagram, or other social platforms, these pages pull in a preview

image and title automatically. Without OpenGraph metadata, social posts show a generic or broken preview,

making your content look unprofessional and reducing click-through rates from social traffic.

Why it matters for your business: Social sharing is a key discovery channel for cannabis retailers; a weak

preview discourages customers from clicking through to your menu, promotions, or product pages.

Technical root cause: The page HTML is missing og:title, og:image, og:url, and og:description meta tags in the

<head> section, so social platforms cannot extract rich preview data.

Recommended fix — step by step

1. Open your site's homepage HTML in a text editor or admin panel and locate the <head> section.

https://litmospheres.com/
https://litmospheres.com/


2. Add the following meta tags before the closing </head> tag: <meta property="og:title"

content="Litmosphere | Cannabis Dispensary"> (customize the title), <meta property="og:image"

content="https://litmospheres.com/path-to-hero-image.jpg"> (link to a 1200×630px branded image), <meta

property="og:url" content="https://litmospheres.com/">, and <meta property="og:description"

content="Your one-line value prop, e.g., 'Premium cannabis products in [City]'.">

3. If using WordPress: install Yoast SEO plugin, go to SEO → Social, upload your social image, and Yoast will

auto-generate og: tags.

4. If using Shopify: go to Settings → Brand → Social Media, upload your OG image and add site description—

Shopify injects these tags automatically.

5. Test the preview by pasting your homepage URL into Facebook's Sharing Debugger

(facebook.com/developers/tools/debug/sharing).

6. Repeat for key pages: product pages, promotion pages, and blog (if any) using dynamic og:image and

og:title tags.

5. Missing OpenGraph metadata

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/hello-world/

Rule: tier2.meta.no-og

What it means (plain English)

Your blog post page is missing Open Graph tags—special metadata that tells Facebook, Instagram, LinkedIn,

and other social platforms how to display your content when someone shares it. Without these tags, social

posts default to basic text and may not show your cannabis products or branding visually, making shares less

engaging.

Why it matters for your business: Lost opportunity to drive traffic from social sharing; posts about your

products won't display with images or custom titles, reducing click-through rates from social platforms where

cannabis customers discover dispensaries.

Technical root cause: The page HTML lacks <meta property="og:title">  and <meta
property="og:image">  tags in the document head, so social platforms have no instruction on how to

preview the page.

Recommended fix — step by step

1. Log into your WordPress admin dashboard (wp-admin/); go to Settings → Reading to confirm your site URL

is correct

2. Install the free Yoast SEO plugin (Plugins → Add New, search 'Yoast'); activate it

3. Go to Yoast SEO → Social → Facebook tab; enable 'Add Open Graph meta tags' and set a default featured

image

4. Edit the blog post at /hello-world/ (Posts → All Posts → Hello World → Edit)

5. In the Yoast SEO metabox at bottom, go to Social tab; upload or select a cannabis product image for

og:image (minimum 1200×630px recommended)

6. Set the og:title in Yoast's Social Preview to your desired share title (e.g., 'Cannabis Product Name —

Litmosphere Dispensary')

7. Click Update to publish; test the fix using Facebook's Sharing Debugger

(facebook.com/developers/tools/debug/sharing/) by pasting your post URL

https://litmospheres.com/path-to-hero-image.jpg%22%3E
https://litmospheres.com/%22%3E,
https://litmospheres.com/hello-world/


6. Missing Twitter card

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/hello-world/

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your site is missing a Twitter Card meta tag, which is a small code snippet that tells Twitter (X) how to display

your content when someone shares a link. Without it, Twitter shows a plain link with minimal information instead

of an attractive preview with your image, headline, and description.

Why it matters for your business: When customers share your products or blog posts on Twitter/X, missing

cards result in low-engagement, plain-text previews that don't drive clicks back to your site or showcase your

brand.

Technical root cause: The page lacks the <meta name="twitter:card"
content="summary_large_image">  tag and related Twitter Card meta tags (twitter:title,

twitter:description, twitter:image) in the HTML head section.

Recommended fix — step by step

1. Open the HTML source of your homepage and blog posts (e.g., /hello-world/)

2. Add this meta tag block inside the <head> section: <meta name="twitter:card"
content="summary_large_image"><meta name="twitter:title" content="[Your
Page Title]"><meta name="twitter:description" content="[Your Page
Description]"><meta name="twitter:image" content="[URL to high-quality
image, 1200×630px]">

3. If using a WordPress theme, install the Yoast SEO or Rank Math plugin, go to Settings → Social, enable

Twitter/X card, and fill in the required fields

4. Test the fix using Twitter's Card Validator (cards-dev.twitter.com/validator) by pasting your URL

5. Repeat for key pages: product pages, blog posts, and your homepage

7. 3 image(s) missing alt text

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://litmospheres.com/hello-world/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Three images on your 'Hello World' page don't have alt text — a short text description that tells screen readers

and search engines what the image shows. This makes those images invisible to people using assistive

technology and signals to Google that you haven't optimized for accessibility.

Why it matters for your business: Missing alt text reduces SEO value for image search (many cannabis

customers search for product photos), and it excludes customers with visual impairments or slow connections

from understanding your content.

https://litmospheres.com/hello-world/
https://litmospheres.com/hello-world/


Technical root cause: Images were inserted into the page without the 'alt' HTML attribute, which is required for

accessibility compliance and search engine indexing.

Recommended fix — step by step

1. Open https://litmospheres.com/hello-world/ in a browser and identify the 3 images that need alt text

2. Right-click each image and select 'Inspect' to locate the <img> tag in the HTML

3. For each <img> tag, add an 'alt' attribute with a 1–10 word description (e.g., <img src='product.jpg'

alt='Litmosphere purple strain flower in glass jar'>)

4. Ensure alt text describes the image content, not generic text like 'image' or 'photo'

5. Save and refresh the page to confirm the change

6. Run the page through a free accessibility checker like WebAIM WAVE (https://wave.webaim.org/) to confirm

all images now have alt text

8. Missing OpenGraph metadata

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/services/

Rule: tier2.meta.no-og

What it means (plain English)

Your Services page doesn't include Open Graph tags — special metadata that tells social media platforms

(Facebook, Instagram, LinkedIn) what image and headline to display when someone shares your link. Without

these tags, social shares show a generic preview instead of your chosen branding.

Why it matters for your business: When customers share your services page on social media, it will display a

generic or broken preview instead of a professional image and headline, reducing click-through rates and brand

consistency in social feeds.

Technical root cause: The HTML <head> section is missing og:title and og:image meta tags. Social platforms

fall back to page title and the first image they find, which is unpredictable and often unflattering.

Recommended fix — step by step

1. Open https://litmospheres.com/services/ in a browser, right-click → View Page Source, and search for <meta

property="og:. Note what's missing.

2. If you use WordPress, install Yoast SEO or All in One SEO Pack (free version). Go to Plugins → Add New,

search the plugin name, install and activate.

3. In Yoast SEO, go to each page (Services included) and fill in Social Previews: set og:title to a compelling

headline (e.g., 'Premium Cannabis Services | Litmosphere') and upload og:image (1200×630px minimum).

4. If platform is custom HTML: add these two lines to the <head> of services/index.html (or equivalent): <meta

property="og:title" content="Premium Cannabis Services | Litmosphere"> and <meta property="og:image"

content="https://litmospheres.com/path-to-image.jpg">.

5. Test the fix using Facebook's Sharing Debugger (facebook.com/sharing/debugger) — paste your services

URL and verify the preview shows your image and headline.

9. Missing OpenGraph metadata

Severity: P3 | Priority: 🟡  MEDIUM

https://litmospheres.com/hello-world/
https://wave.webaim.org/)
https://litmospheres.com/services/
https://litmospheres.com/services/
https://litmospheres.com/path-to-image.jpg%22%3E.


Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/castleton-on-hudson/

Rule: tier2.meta.no-og

What it means (plain English)

When your product pages are shared on social media (Facebook, Instagram, LinkedIn), those platforms look for

special metadata tags called OpenGraph tags to display a preview with your page title and image. Without

og:title and og:image, social shares show a generic preview that doesn't represent your products or brand,

making the link less attractive to click.

Why it matters for your business: Poor social media previews reduce click-through rates when customers

share your products with friends, directly limiting organic word-of-mouth traffic and product discovery for your

dispensary.

Technical root cause: The page HTML is missing <meta property="og:title"> and <meta property="og:image">

tags in the document head. When absent, platforms cannot fetch rich preview data and fall back to generic

defaults.

Recommended fix — step by step

1. Inspect the HTML source of https://litmospheres.com/castleton-on-hudson/ (right-click → View Page

Source, search for 'og:' to confirm tags are missing)

2. Add <meta property="og:title" content="[Product/Page Name]"> in the <head> section of each affected

page template

3. Add <meta property="og:image" content="[URL to a 1200×630px product image]"> pointing to a high-

quality image that represents the product

4. Also add <meta property="og:description" content="[40-160 character summary]"> and <meta

property="og:url" content="[canonical page URL]"> for complete social previews

5. If using a CMS, check if there is an SEO plugin (Yoast SEO for WordPress, Moz for other platforms) that can

auto-generate these tags; enable the social media section

6. Test the fix by pasting the URL into Facebook's Sharing Debugger

(facebook.com/developers/tools/debug/sharing) to preview how it will appear when shared

10. Missing OpenGraph metadata

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/contact/

Rule: tier2.meta.no-og

What it means (plain English)

OpenGraph metadata tells social media platforms (Facebook, Instagram, LinkedIn) how to display your page

when someone shares it. Without og:title and og:image, your contact page will show a generic preview instead

of your branded message, making shared links look unprofessional.

Why it matters for your business: When customers share your contact page on social media, it won't display

your dispensary name or a compelling image, reducing click-through rates and brand recognition in social

feeds.

https://litmospheres.com/castleton-on-hudson/
https://litmospheres.com/castleton-on-hudson/
https://litmospheres.com/contact/


Technical root cause: The contact page's HTML <head> section is missing <meta property="og:title"> and

<meta property="og:image"> tags that social platforms use to generate rich previews.

Recommended fix — step by step

1. Open your contact page HTML in a code editor or your platform's page editor

2. Add this line in the <head> section: <meta property="og:title" content="Contact Litmosphere - Cannabis

Dispensary">

3. Add this line in the <head> section: <meta property="og:image" content="https://litmospheres.com/path-to-

your-logo-or-branded-image.jpg"> (replace with actual image URL)

4. Add this line in the <head> section: <meta property="og:description" content="Get in touch with

Litmosphere. Hours, location, and customer support.">

5. Test the fix using Facebook's Sharing Debugger (facebook.com/sharing/debugger/) — paste the contact

page URL and verify the preview now shows your title and image

6. Repeat for other key pages (product pages, home page) to ensure consistent social sharing

11. Missing OpenGraph metadata

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/in-store-pickup/

Rule: tier2.meta.no-og

What it means (plain English)

When people share your in-store pickup page on social media (Facebook, Instagram, etc.), those platforms

don't have a nice preview card to display. Instead, they show a generic or broken-looking snippet. OpenGraph

tags are special HTML codes that tell social platforms what image and headline to show when your page is

shared.

Why it matters for your business: Poor social sharing previews reduce click-through rates when customers

share your dispensary's pickup option with friends, directly limiting organic word-of-mouth traffic and brand

awareness.

Technical root cause: The page's HTML <head> section is missing og:title and og:image meta tags that social

platforms require to generate rich preview cards.

Recommended fix — step by step

1. Open your page source (right-click → View Page Source) and locate the <head> section

2. Add this line: <meta property="og:title" content="In-Store Pickup | Litmosphere">

3. Add this line: <meta property="og:image" content="https://litmospheres.com/path-to-your-logo-or-product-

photo.jpg"> (use a 1200×630px image)

4. Add this line: <meta property="og:description" content="Quick, easy in-store pickup at Litmosphere

dispensary">

5. Test the fix by pasting your URL into Facebook's Sharing Debugger (facebook.com/sharedebugger) and

Instagram's Link Previewer

6. If using a CMS (WordPress, Shopify, etc.), install Yoast SEO or similar plugin and fill in the Social Preview

fields for this page instead of editing HTML directly

12. Missing Twitter card

https://litmospheres.com/path-to-your-logo-or-branded-image.jpg%22%3E
https://litmospheres.com/path-to-your-logo-or-branded-image.jpg%22%3E
https://litmospheres.com/in-store-pickup/
https://litmospheres.com/path-to-your-logo-or-product-photo.jpg%22%3E
https://litmospheres.com/path-to-your-logo-or-product-photo.jpg%22%3E


Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/in-store-pickup/

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your website is missing Twitter Card tags, which are special metadata that tell Twitter (now X) how to display

your pages when someone shares a link. Without them, the platform shows a plain, unformatted preview instead

of your custom title, description, and image. For a cannabis retailer, this means social shares look

unprofessional and miss the chance to drive traffic.

Why it matters for your business: Missing Twitter Cards reduce click-through rates on social media shares

and make your in-store pickup and product pages appear less trustworthy when customers share them, directly

impacting foot traffic and online visibility.

Technical root cause: The <meta name="twitter:card"> tag and related Twitter Card meta tags (twitter:title,

twitter:description, twitter:image) are not present in the HTML <head> of this page.

Recommended fix — step by step

1. Open your page source (right-click → View Page Source) and locate the <head> section to confirm Twitter

Card tags are missing.

2. Add these four meta tags to the <head> of every page: <meta name="twitter:card"

content="summary_large_image"> <meta name="twitter:title" content="[Your Page Title]"> <meta

name="twitter:description" content="[Brief description under 200 chars]"> <meta name="twitter:image"

content="[URL to a 1200x628px image]">

3. If you use WordPress, install the Yoast SEO plugin (free version), go to Tools → Social, and enable Twitter

settings to auto-generate these tags.

4. If you use Shopify, go to Settings → Checkout → Order status page, then enable social sharing metadata.

5. Test your fix by visiting https://cards-dev.twitter.com/validator and pasting your page URL to preview how it

will appear in Twitter/X shares.

6. Apply the same Twitter Card tags to your product pages, blog posts, and key landing pages (in-store pickup,

product listings).

13. 3 image(s) missing alt text

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://litmospheres.com/in-store-pickup/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Three images on your in-store pickup page don't have alt text—descriptive labels that screen readers use to tell

visually impaired visitors what an image shows. This hurts both accessibility (people using screen readers can't

understand those images) and SEO (search engines can't index image content without descriptions).

Why it matters for your business: Customers using assistive technology may skip your page or leave

frustrated; you're also losing potential search traffic from image searches and missing SEO ranking signals.

https://litmospheres.com/in-store-pickup/
https://cards-dev.twitter.com/validator
https://litmospheres.com/in-store-pickup/


Technical root cause: The HTML img tags lack alt attributes, or the attributes are empty (alt=""). Without

these, browsers and search engines have no text description of the images.

Recommended fix — step by step

1. Open https://litmospheres.com/in-store-pickup/ in a browser and inspect each image element (right-click →

Inspect or use browser DevTools)

2. Identify the 3 images missing alt text—note their visual content (e.g., 'store front', 'pickup counter', 'product

shelf')

3. Edit the page's HTML or use your CMS page editor to add descriptive alt text to each img tag; example:

<img src="pickup-counter.jpg" alt="In-store pickup counter with staff member">

4. Keep alt text 120 characters or fewer, factual, and specific (avoid 'image' or 'photo')

5. Save and publish the page

6. Use a free accessibility checker like WAVE (wave.webaim.org) to re-scan the page and confirm all 4 images

now have alt text

14. Missing OpenGraph metadata

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: revenue

Page URL: https://litmospheres.com/online-ordering/

Rule: tier2.meta.no-og

What it means (plain English)

OpenGraph (OG) tags are snippets of code that control how your pages look when shared on Facebook,

Instagram, LinkedIn, and other social platforms. Without og:title and og:image tags, when someone shares your

online ordering page, it shows up as a generic, unappealing preview instead of a branded image with your

business name and a clear call-to-action.

Why it matters for your business: Missing OG tags reduce click-through rates on social shares, making it less

likely that potential customers will visit your site when your content is shared by staff or existing customers on

social media.

Technical root cause: The /online-ordering/ page does not include <meta property="og:title" content="..."> or

<meta property="og:image" content="..."> tags in its HTML <head> section, so social platforms fall back to

generic parsing of page content.

Recommended fix — step by step

1. Open the HTML source of https://litmospheres.com/online-ordering/ and locate the <head> section

2. Add <meta property="og:title" content="Online Ordering | Litmosphere"> before the closing </head> tag

3. Add <meta property="og:image" content="https://litmospheres.com/[path-to-branded-image].jpg"> (use a

1200×630px image of your dispensary or product)

4. Add <meta property="og:description" content="Order cannabis products online for fast, convenient

pickup.">

5. Add <meta property="og:url" content="https://litmospheres.com/online-ordering/">

6. Test the result using Facebook's Sharing Debugger (facebook.com/sharing/debugger/) to confirm the

preview displays correctly

7. Repeat for other high-traffic pages (homepage, product pages, blog posts)

https://litmospheres.com/in-store-pickup/
https://litmospheres.com/online-ordering/
https://litmospheres.com/online-ordering/
https://litmospheres.com/[path-to-branded-image].jpg%22%3E
https://litmospheres.com/online-ordering/%22%3E


15. Missing Twitter card

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/online-ordering/

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your site is missing a Twitter Card meta tag, which is a snippet of code that tells Twitter how to display your

page when someone shares it on that platform. Without it, Twitter shows a plain, unformatted preview instead of

a rich card with your brand imagery and product details.

Why it matters for your business: Social sharing is free marketing; a missing Twitter Card means fewer people

will click through from Twitter, reducing organic traffic and brand visibility when customers share your products

or promotions.

Technical root cause: The HTML page lacks a <meta name="twitter:card"
content="summary_large_image">  tag and related Twitter meta tags (twitter:image, twitter:title,

twitter:description) in the page head.

Recommended fix — step by step

1. Add this meta tag to the <head> of your online-ordering page (or global header template): <meta

name="twitter:card" content="summary_large_image">

2. Add <meta name="twitter:title" content="[Your Product/Page Title]"> with your online ordering title

3. Add <meta name="twitter:description" content="[Brief product/service description]">

4. Add <meta name="twitter:image" content="[Full URL to a 1200×630px brand image or product photo]">

5. Add <meta name="twitter:site" content="@YourTwitterHandle"> if you have a brand Twitter account

6. If using WordPress, install a plugin like Yoast SEO or Rank Math and configure Twitter settings in Settings →

Social or the plugin dashboard

7. Test your card at https://cards-dev.twitter.com/validator to confirm it displays correctly before sharing

16. 3 image(s) missing alt text

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://litmospheres.com/online-ordering/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Three images on your online ordering page lack alt text — descriptive text that screen readers announce to

visitors with visual impairments, and that search engines use to understand what images show. This makes the

page harder for people using accessibility tools and slightly reduces image visibility in search results.

Why it matters for your business: Missing alt text blocks disabled customers from understanding product

images and ordering, and leaves SEO value on the table for product images that could rank in Google Image

Search.

https://litmospheres.com/online-ordering/
https://cards-dev.twitter.com/validator
https://litmospheres.com/online-ordering/


Technical root cause: Images were added to the page without alt attributes in the HTML, either during page

build or via a CMS that didn't require alt text at upload.

Recommended fix — step by step

1. Open https://litmospheres.com/online-ordering/ in your browser and identify the 3 images missing alt text

(use browser Inspector → Elements → search for <img> tags with no alt attribute)

2. For each image, write a 5–10 word description of what it shows (e.g., 'Litmosphere cannabis flower eighth-

ounce package' for a product photo)

3. If using WordPress: go to Media → Library, find each image, click Edit, and fill the 'Alternative Text' field;

save and republish the page

4. If editing HTML directly: add alt="[your description]" to each <img> tag and redeploy

5. Test with a free tool like WAVE (wave.webaim.org) or axe DevTools browser extension to confirm all images

now have alt text

6. Consider adding a CMS workflow rule or plugin (e.g., Yoast SEO for WordPress) to flag missing alt text

before publish

17. Missing OpenGraph metadata

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/education-community/

Rule: tier2.meta.no-og

What it means (plain English)

When your Education & Community page is shared on social media (Facebook, Instagram, LinkedIn), those

platforms need specific metadata tags to know what title and image to display in the preview. Without these

tags, social shares show generic or broken previews, which looks unprofessional and discourages clicks.

Why it matters for your business: Poor social media previews reduce click-through rates on shared content,

limiting organic reach and community engagement — especially critical for a cannabis brand building trust

through educational content.

Technical root cause: The page is missing og:title and og:image meta tags in the HTML head. Social platforms

fall back to page title and favicon, which rarely create compelling previews.

Recommended fix — step by step

1. Open the Education & Community page HTML source and locate the <head> section

2. Add <meta property="og:title" content="[Your chosen page title]"> — use a compelling 50–60 character

title specific to that page's content

3. Add <meta property="og:image" content="https://litmospheres.com/path/to/image.jpg"> — use a

1200×630px image that reflects the education topic

4. Also add <meta property="og:description" content="[2–3 sentence summary]"> for complete social

metadata

5. Repeat for all major pages (product pages, blog posts, homepage) — prioritize high-traffic pages first

6. Test the fix using Facebook's Sharing Debugger (facebook.com/sharing/debugger) and LinkedIn's Post

Inspector to verify previews render correctly

18. Missing OpenGraph metadata

https://litmospheres.com/online-ordering/
https://litmospheres.com/education-community/
https://litmospheres.com/path/to/image.jpg%22%3E


Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/about-us/

Rule: tier2.meta.no-og

What it means (plain English)

Your About Us page is missing OpenGraph metadata—special tags that control how your page appears when

shared on Facebook, Instagram, or other social platforms. Without these tags, when someone shares your link,

it won't show a custom title or image, making the share look unprofessional and reducing click-through rates.

Why it matters for your business: Missed social media visibility and engagement; shared links appear generic

instead of branded, reducing traffic from social platforms where many cannabis consumers discover

dispensaries.

Technical root cause: The page HTML lacks og:title and og:image meta tags in the <head> section. These tags

are not automatically generated by most website builders and must be explicitly added.

Recommended fix — step by step

1. Inspect the HTML source of https://litmospheres.com/about-us/ (right-click → View Page Source) and locate

the <head> section

2. Add og:title: <meta property="og:title" content="About Litmosphere | Cannabis Dispensary">

3. Add og:image: <meta property="og:image" content="[URL to a 1200x630px branded image]"> — choose a

high-quality logo or dispensary photo

4. Also add og:description: <meta property="og:description" content="Learn about our cannabis selection and

values.">

5. If using a CMS (WordPress, Shopify, etc.), install Yoast SEO or All in One SEO and fill the Social Preview

fields for this page

6. Test the fix using Facebook's Sharing Debugger (facebook.com/developers/tools/debug/sharing/) and paste

your URL to preview

7. Repeat for all other key pages: homepage, product category pages, and contact page

19. Missing OpenGraph metadata

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/accessibility/

Rule: tier2.meta.no-og

What it means (plain English)

Your /accessibility/ page is missing OpenGraph tags — special HTML code that tells social media platforms

(Facebook, Instagram, LinkedIn) what to display when someone shares the link. Without these tags, the share

preview looks generic and unattractive, which reduces click-through rates on social posts.

Why it matters for your business: When customers try to share your accessibility page on social media, it

won't show a branded preview with your logo or a compelling image, making the share less likely to drive traffic

back to your site.

https://litmospheres.com/about-us/
https://litmospheres.com/about-us/
https://litmospheres.com/accessibility/


Technical root cause: The page's HTML <head> section lacks og:title and og:image meta tags. Social

platforms fall back to generic defaults when these are missing.

Recommended fix — step by step

1. Open the HTML source of https://litmospheres.com/accessibility/ and locate the closing </head> tag.

2. Add this line before </head>: <meta property="og:title" content="Accessibility | Litmosphere">

3. Add this line before </head>: <meta property="og:image" content="https://litmospheres.com/path-to-your-

logo-or-hero-image.jpg"> (replace path-to-your-logo-or-hero-image.jpg with your actual image URL).

4. Optional: Also add <meta property="og:description" content="Learn how Litmosphere is committed to

accessibility."> for a complete social preview.

5. Save and publish the changes.

6. Test the fix by pasting the URL into Facebook's Sharing Debugger

(facebook.com/developers/tools/debug/sharing/) to see the preview.

20. 2 image(s) missing alt text

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://litmospheres.com/accessibility/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Your accessibility page contains 2 images that lack descriptive alt text — the hidden labels that screen readers

announce to visually impaired visitors and that search engines use to understand image content. This creates

barriers for both customers and search ranking.

Why it matters for your business: Visually impaired customers cannot understand what those images show,

reducing trust and compliance; search engines also rank pages with properly labeled images higher, so this is

costing you SEO points on a page meant to showcase your commitment to accessibility.

Technical root cause: The images were added to the HTML without alt attributes, either during initial page

build or a recent CMS content update.

Recommended fix — step by step

1. Open https://litmospheres.com/accessibility/ in a browser and take a screenshot of the 2 missing-alt images

to identify what they depict.

2. If you manage content via WordPress: log in → Pages → find 'Accessibility' → click Edit → locate each image

block → click the image → expand 'Alt text' field in the sidebar → write a brief 1–2 sentence description (e.g.,

'Team member Jamie presenting accessibility training workshop').

3. If you manage content via a different CMS (Shopify, custom): find the image editor and add descriptive text

to the alt attribute field.

4. If you don't have CMS access: contact your web vendor with the screenshots and ask them to add alt text to

the 2 images; provide them the descriptions you wrote in step 2.

5. Save/publish the changes.

6. Use a free browser tool like WAVE (https://wave.webaim.org/) to re-scan the page and confirm both images

now show alt text.

21. Missing OpenGraph metadata
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Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/cannabis-dispensary-castleton-on-hudson-ny/

Rule: tier2.meta.no-og

What it means (plain English)

When someone shares your dispensary location page on Facebook, Instagram, or other social platforms, those

platforms pull in a preview image and headline. Without OpenGraph metadata (special tags that tell social

platforms what to display), your page shows a generic or broken preview, making the shared link look

unprofessional and less clickable.

Why it matters for your business: Poor social previews reduce click-through rates when customers share your

dispensary location with friends, directly hurting foot traffic and online visibility in a competitive market.

Technical root cause: The page is missing og:title and og:image meta tags in the HTML <head> section. Social

platforms default to generic fallbacks when these tags are absent.

Recommended fix — step by step

1. Open your page source (right-click → View Page Source) and search for '<meta property="og:' to confirm

og:title and og:image are missing.

2. Add '<meta property="og:title" content="Litmosphere Cannabis Dispensary – Castleton-on-Hudson, NY">'

to the <head> section.

3. Add '<meta property="og:image" content="[full URL to a 1200x630px dispensary photo or logo]">' to the

<head>.

4. Also add '<meta property="og:description" content="Visit our dispensary in Castleton-on-Hudson for

premium cannabis products.">' for a complete preview.

5. Test the fix using Facebook's Sharing Debugger (facebook.com/sharing/debugger/) — paste your URL and

refresh to see the new preview.

6. If you use a CMS (WordPress, Shopify, etc.), check if an SEO plugin like Yoast SEO or Rankmath can auto-

generate these tags instead of manual HTML edits.

22. Missing Twitter card

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/cannabis-dispensary-castleton-on-hudson-ny/

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your product pages are missing Twitter Card meta tags — special HTML code that tells Twitter how to display

your content when someone shares a link to your site on Twitter/X. Without this, your posts appear as plain text

links instead of attractive preview cards with your logo, product image, and description.

Why it matters for your business: Missing Twitter Cards reduce click-through rates on social shares, making

your cannabis products less visually appealing when staff, customers, or influencers post about Litmosphere on

Twitter/X.

https://litmospheres.com/cannabis-dispensary-castleton-on-hudson-ny/
https://litmospheres.com/cannabis-dispensary-castleton-on-hudson-ny/


Technical root cause: The page HTML does not include <meta name="twitter:card"
content="summary_large_image">  and related open graph meta tags (og:image, og:title,

og:description) in the <head>  section.

Recommended fix — step by step

1. Open your page template editor and locate the <head> section of https://litmospheres.com/cannabis-

dispensary-castleton-on-hudson-ny/

2. Add these four meta tags before the closing </head>: <meta name="twitter:card"
content="summary_large_image"> , <meta name="twitter:title" content="
[Product/Page Title]"> , <meta name="twitter:description" content="[Product
description]"> , <meta name="twitter:image" content="[Image URL]">  (and also

add equivalent og:* tags for all social platforms)

3. Test the fix using Twitter's Card Validator (cards-dev.twitter.com/validator) — paste your URL and confirm

the preview shows correctly

4. Apply the same meta tags to all product and dispensary location pages using your site template system

5. For best results, ensure your og:image is at least 1200x630px and under 5MB

23. Missing OpenGraph metadata

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/dispensary-schodack-ny/

Rule: tier2.meta.no-og

What it means (plain English)

Open Graph tags are snippets of code that tell social media platforms (Facebook, Instagram, LinkedIn) how to

display your page when someone shares it. Without og:title and og:image, your dispensary's location page will

show up as a generic, unattractive preview when customers share it—missing your branding, location info, and a

compelling image.

Why it matters for your business: Missing Open Graph tags reduce the likelihood that shared content drives

traffic back to your site; potential customers see bland previews instead of professional branding, hurting word-

of-mouth social sharing and local visibility.

Technical root cause: The page's HTML head section lacks og:title, og:image, and related Open Graph meta

tags that social platforms parse when generating share previews.

Recommended fix — step by step

1. Audit your site's template for the dispensary location pages and identify where meta tags are generated—

check the HTML <head> section of https://litmospheres.com/dispensary-schodack-ny/

2. Add these Open Graph meta tags to every dispensary location page: <meta property="og:title"

content="Litmosphere Dispensary – Schodack, NY"> and <meta property="og:image" content="[URL to

high-quality dispensary photo or logo, 1200×630px minimum]">

3. Also add og:description (150 characters summarizing the location) and og:url (the canonical page URL) for

completeness

4. If using a CMS (WordPress, Shopify, etc.), install an SEO plugin like Yoast SEO or All in One SEO and

configure Open Graph templates for location pages in the plugin settings

https://litmospheres.com/cannabis-dispensary-castleton-on-hudson-ny/
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5. Test the fix using Facebook's Sharing Debugger (facebook.com/sharing/debugger) and LinkedIn's Post

Inspector to confirm the preview now displays your branding and image

24. Missing Twitter card

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/dispensary-schodack-ny/

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your product pages are missing Twitter Card tags, which are small code snippets that tell Twitter how to display

your link when someone shares it on that platform. Without them, Twitter shows a plain, generic preview instead

of your product image, name, and description—making your posts look less professional and less clickable.

Why it matters for your business: Missed social sharing engagement: customers who share your dispensary

location or products on Twitter will see a bland preview, reducing click-through rates and brand visibility on a

platform where cannabis enthusiasts and advocates are active.

Technical root cause: The page's HTML head section lacks <meta name="twitter:card">  and

related tags (twitter:image, twitter:title, twitter:description). These are optional meta tags that enhance social

sharing but are not generated by default.

Recommended fix — step by step

1. Audit your top 5 product/location pages to identify which ones drive the most social traffic (use Google

Analytics → Behavior → All Pages, filter by referral from twitter.com or t.co).

2. Add Twitter Card meta tags to the HTML head of your main dispensary pages: <meta
name="twitter:card" content="summary_large_image"> , <meta
name="twitter:title" content="[Product/Location Name]"> , <meta
name="twitter:description" content="[Brief description]"> , <meta
name="twitter:image" content="[URL to product image]"> , and <meta
name="twitter:site" content="@YourTwitterHandle">  (if you have one).

3. Ensure the twitter:image URL points to a high-quality product or dispensary photo (minimum 300×300px,

recommended 1200×675px for summary_large_image).

4. Test your implementation using Twitter's Card Validator (https://cards-dev.twitter.com/validator) — paste

your dispensary URL and verify the preview renders correctly.

5. If using WordPress, install the Yoast SEO or Rank Math plugin (both include Twitter Card controls): go to

plugin settings → Social → Twitter section → enable and fill in card details for each page, or use their bulk

meta template.

6. If on a custom platform, add these tags to your page template and deploy to production.

7. Monitor social engagement on Twitter for 2–4 weeks post-fix to confirm improved click-through rates.

25. Missing OpenGraph metadata

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

https://litmospheres.com/dispensary-schodack-ny/
https://cards-dev.twitter.com/validator)


Page URL: https://litmospheres.com/dispensary-near-east-greenbush-ny/

Rule: tier2.meta.no-og

What it means (plain English)

Open Graph tags are snippets of code that tell social platforms (Facebook, Instagram, LinkedIn) what image and

text to display when someone shares your link. Without them, your dispensary page shows up as a plain link

with no preview, making it less likely people will click through from social media.

Why it matters for your business: Social sharing is a free marketing channel for dispensaries; without OG

tags, shared links look unprofessional and get fewer clicks, reducing foot traffic and online visibility.

Technical root cause: The page's HTML header is missing <meta property="og:title">  and

<meta property="og:image">  tags, so social platforms have no instruction on what to display when

the URL is shared.

Recommended fix — step by step

1. Open your page HTML editor or CMS (WordPress, Shopify, etc.) and locate the <head>  section of

https://litmospheres.com/dispensary-near-east-greenbush-ny/

2. Add these four lines before the closing </head>  tag: <meta property="og:title"
content="Litmosphere Dispensary Near East Greenbush, NY"> , <meta
property="og:description" content="[Your 160-character description]"> ,
<meta property="og:image" content="[Full URL to 1200x630px image]"> , and
<meta property="og:url" content="https://litmospheres.com/dispensary-near-
east-greenbush-ny/">

3. Use a high-quality image (at least 1200×630 pixels) showing your storefront or a product photo; avoid blurry

or text-heavy images

4. Test the fix using Facebook's Sharing Debugger (facebook.com/sharing/debugger/) — paste your URL and

verify the preview looks correct

5. Apply the same OG tags to all other location pages and key content pages (product pages, about, etc.)

26. Missing Twitter card

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/dispensary-near-east-greenbush-ny/

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your product pages are missing Twitter card metadata — special HTML tags that tell Twitter (now X) how to

display your content when someone shares a link. Without them, the platform shows a plain, generic preview

instead of your product photo, description, and branding. This makes shared links less compelling and less

likely to drive clicks.

Why it matters for your business: Missing Twitter cards reduce click-through rates on social shares, which

cuts organic traffic from X and limits brand visibility among cannabis consumers who discover dispensaries

through social channels.

Technical root cause: The page HTML lacks <meta name="twitter:card"> , twitter:image ,
twitter:title , and twitter:description  tags in the document head. Without these, X defaults
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to a minimal text-only preview.

Recommended fix — step by step

1. Open the page HTML source (View → Page Source in browser) and locate the <head> section.

2. Add the following meta tags before the closing </head>: <meta name="twitter:card"
content="summary_large_image"> , <meta name="twitter:title" content="[Page
Title]"> , <meta name="twitter:description" content="[Page Description]"> ,
<meta name="twitter:image" content="[URL to dispensary/product photo,
1200×630px]"> , <meta name="twitter:site" content="@[your X handle]">  (if you

have one).

3. If using WordPress, install the free Yoast SEO or Rank Math plugin; both auto-generate Twitter cards from

your page title and featured image.

4. If using a headless CMS or custom code, add the tags to your page template and deploy.

5. Share a test link (e.g., your dispensary near East Greenbush page) on X using the Card Validator tool (cards-

dev.twitter.com/validator) to verify the preview renders correctly.

6. Repeat for other high-traffic product/dispensary pages.

27. Title length 18 chars

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/?elementor_library=insta

Rule: tier2.meta.title-length

What it means (plain English)

Your homepage title tag (the text that appears in browser tabs and search results) is only 18 characters long.

Search engines prefer titles between 20–65 characters because longer, descriptive titles help customers

understand what your page is about before clicking. Your current title is too short to take full advantage of

search visibility.

Why it matters for your business: A weak title tag reduces click-through rates from Google search results and

fails to communicate your dispensary's key offerings (location, products, promotions) to potential customers

searching for cannabis products nearby.

Technical root cause: The title tag in your page's HTML head section was likely set to a generic default during

theme setup. It does not include descriptive keywords like your location, product categories, or brand

differentiators that would naturally extend the character count.

Recommended fix — step by step

1. Log in to your site admin and access the page editor for your homepage (likely via Elementor or WordPress

editor).

2. Open the SEO settings panel (look for 'SEO' or 'Meta' tab, or use a plugin like Yoast SEO if installed).

3. Replace 'Home | Litmosphere' with a 50–60 character title such as 'Cannabis Dispensary & Weed Products |

Litmosphere' or include your city/location if relevant.

4. Ensure the new title includes your brand name, primary product category, and a location or value prop (e.g.,

'Premium Cannabis Dispensary in [City] | Litmosphere – Fast Delivery & Selection').

5. Save and publish the change.

6. Wait 24–48 hours, then check Google Search Console to confirm the new title appears in search results.

https://litmospheres.com/?elementor_library=insta


28. Missing OpenGraph metadata

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://litmospheres.com/?elementor_library=insta

Rule: tier2.meta.no-og

What it means (plain English)

OpenGraph tags are snippets of code that control how your website appears when shared on social media

platforms like Instagram, Facebook, and Twitter. Without these tags, your pages show up with generic or broken

previews, making shared links look unprofessional and less clickable.

Why it matters for your business: Poor social media previews reduce click-through rates when customers

share your products or promotions, directly impacting traffic and brand perception in a visual-first industry like

cannabis retail.

Technical root cause: The affected page (an Elementor library template page) lacks og:title and og:image meta

tags in its HTML head section, likely because it's an internal template not designed for social sharing but is still

indexable.

Recommended fix — step by step

1. Identify all public-facing pages that should be shareable (product pages, promotions, homepage) and

exclude internal template/library pages from search indexing by adding noindex,nofollow to their robots

meta tag or via your sitemap.

2. Add og:title, og:image, og:url, and og:description meta tags to your site-wide template or via a plugin (if

WordPress: use Yoast SEO or RankMath; go to Settings → Social to enable OpenGraph output).

3. For the specific ?elementor_library=insta page: either set it to noindex via your SEO plugin, or if it should be

public-facing, manually add og:title and og:image tags before the closing </head> tag.

4. Test social sharing by pasting your URLs into Facebook Sharing Debugger (facebook.com/sharing/debugger)

and Twitter Card Validator (twitter.com/login?redirect_url=https://cards-dev.twitter.com/validator) to verify

previews render correctly.

29. Title length 18 chars

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/?elementor_library=default-kit

Rule: tier2.meta.title-length

What it means (plain English)

Your homepage title tag (the text that appears in browser tabs and search results) is only 18 characters long.

Search engines and users prefer titles between 20 and 65 characters because longer titles give more context

about what the page offers. Right now, your title is too short to fully explain what Litmosphere does.

Why it matters for your business: A weak title reduces click-through rates from Google search results and

misses an opportunity to include relevant keywords (like your location or product category) that help customers

find you.

https://litmospheres.com/?elementor_library=insta
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Technical root cause: The title tag in your site's HTML <head> section is set to a generic 'Home | Litmosphere'

without descriptive keywords or value proposition.

Recommended fix — step by step

1. Log into your WordPress admin dashboard and go to Yoast SEO → Search Appearance → Homepage (or

equivalent SEO plugin if you're not using Yoast)

2. Update the SEO Title field to something like 'Premium Cannabis Products & Dispensary | Litmosphere [Your

City]' (aim for 55–60 characters total)

3. If you're not using an SEO plugin, ask your web host to help you edit the <title> tag directly in your site's

header.php or theme settings

4. After saving, use Google Search Console (google.com/webmasters) → URL Inspection → Inspect your

homepage to confirm Google sees the new title within 24 hours

30. Missing OpenGraph metadata

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/?elementor_library=default-kit

Rule: tier2.meta.no-og

What it means (plain English)

Open Graph tags are invisible snippets of code that tell social media platforms (Facebook, Instagram, LinkedIn)

how to display your content when someone shares a link. Without them, your posts will show a generic preview

instead of your brand's logo, product photo, or custom headline—making social shares look unprofessional and

getting fewer clicks.

Why it matters for your business: Cannabis retailers rely heavily on social media to drive traffic and build

community; missing OG tags mean your Instagram and Facebook shares look broken, reducing click-through

rates from social traffic by 20–40% and hurting brand perception.

Technical root cause: The Elementor page template (default-kit) lacks og:title and og:image meta tags in its

<head> section. This is likely a theme/builder configuration gap rather than a site-wide issue, since only this

specific URL was detected.

Recommended fix — step by step

1. Log into your WordPress admin dashboard (litmospheres.com/wp-admin) and go to Posts/Pages → find the

page using Elementor library or the affected URL parameter.

2. In the Elementor editor or page settings, locate the SEO/Meta section (usually in page settings > Advanced

or an SEO plugin panel like Yoast/Rank Math).

3. Add og:title: use your page headline (e.g., 'Litmosphere | Premium Cannabis & Accessories').

4. Add og:image: upload or link your dispensary logo or a high-quality product/storefront photo (minimum

1200×630px).

5. If using Yoast SEO, go to Dashboard → Integration and enable og: tags, then verify the preview shows

correctly.

6. Test the fix using Facebook's sharing debugger (facebook.com/sharing/debugger/) or LinkedIn Post

Inspector—paste the URL and verify the preview displays your custom image and title.

7. Check if this is a theme-wide issue by auditing a few other pages; if many pages are affected, add og: tags

to your theme's header.php or use an all-in-one SEO plugin like Yoast or Rank Math to auto-generate them

site-wide.

https://litmospheres.com/?elementor_library=default-kit


31. Missing Twitter card

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/?elementor_library=default-kit

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your site is missing a Twitter card meta tag, which is a small piece of code that tells Twitter how to display your

page when someone shares a link on that platform. Without it, Twitter shows a plain text preview instead of an

attractive card with your image, headline, and description.

Why it matters for your business: Cannabis products shared on Twitter/X reach fewer people and look

unprofessional compared to competitors who have Twitter cards set up, reducing organic social reach and

brand perception.

Technical root cause: The meta tag <meta name="twitter:card"
content="summary_large_image">  and related Twitter card properties (twitter:title,

twitter:description, twitter:image) are not present in your page's HTML head section.

Recommended fix — step by step

1. Open your site's header template or theme settings (likely in Elementor's Site Settings or your WordPress

theme customizer)

2. Locate the HTML head section editor or meta tag management area

3. Add these four meta tags: <meta name="twitter:card"
content="summary_large_image"> , <meta name="twitter:site"
content="@YourTwitterHandle"> , <meta name="twitter:title" content="Your
Page Title"> , <meta name="twitter:description" content="Your page
description"> , <meta name="twitter:image"
content="https://litmospheres.com/path-to-product-image.jpg">

4. For consistency with Open Graph (Facebook), also add <meta property="og:image"
content="https://litmospheres.com/path-to-product-image.jpg">  if not already

present

5. Test your setup using Twitter's Card Validator at https://cards-dev.twitter.com/validator

6. Repeat for product pages and any high-traffic landing pages

32. Title length 18 chars

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/?elementor_library=elementor-header-209

Rule: tier2.meta.title-length

What it means (plain English)

Your homepage title tag is only 18 characters long, falling slightly short of the recommended minimum of 20

characters. Title tags are the headline that appears in browser tabs and search results, so this one is too brief to

https://litmospheres.com/?elementor_library=default-kit
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fully communicate what your site offers to potential customers and search engines.

Why it matters for your business: A weak title tag reduces click-through rates from Google search results and

misses an opportunity to reinforce your brand and product offering (cannabis retail) in a prime real estate that

influences both customers and search ranking.

Technical root cause: The title tag in your page's HTML <head> section reads only 'Home | Litmosphere' — it

lacks descriptive keywords about your business type, location, or unique value proposition that search engines

and users expect.

Recommended fix — step by step

1. Inspect the page source (right-click → View Page Source) and find the <title> tag in the <head> section

2. Replace 'Home | Litmosphere' with a 50–60 character title such as 'Premium Cannabis Dispensary |

Litmosphere' or 'Buy Cannabis Online | Litmosphere – [Your Location]'

3. Ensure the new title includes your primary keyword (cannabis, dispensary, retail) and your brand name

4. If using Elementor (based on the affected URL pattern), check Settings → General → Site Title to confirm the

source of the title tag

5. Test the change by searching your domain in Google and verifying the updated title appears in the search

result snippet within 1–2 weeks

33. Title length 18 chars

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/?elementor_library=elementor-footer-215

Rule: tier2.meta.title-length

What it means (plain English)

Your homepage title is only 18 characters long, falling short of Google's recommended 20–65 character range.

Search engines use this title to display your site in results, and a very short title wastes the opportunity to

include keyword phrases that tell customers what you offer.

Why it matters for your business: A weak title reduces click-through rates from search results and misses the

chance to rank for keywords like 'cannabis dispensary' or your location—potential customers may skip your

listing for competitors with clearer, more descriptive titles.

Technical root cause: The page title is set to a generic 'Home | Litmosphere' without descriptive keywords.

Most page title templates default to minimal branding when custom SEO titles aren't specified.

Recommended fix — step by step

1. Log in to your WordPress admin (or CMS dashboard if non-WordPress).

2. Open the Settings or SEO section—look for Yoast SEO, Rank Math, or a native 'Meta Tags' settings panel.

3. Edit the homepage title to something like 'Premium Cannabis Dispensary | Litmosphere [Your City]' (aim for

50–60 characters).

4. Include your main keyword (e.g., 'cannabis dispensary') and city name to improve local search visibility.

5. Verify the affected URL (the elementor-footer-215 parameter suggests a template export query string—

check if this is a staging/export page that should be noindexed or removed from sitemap).

34. Missing OpenGraph metadata

https://litmospheres.com/?elementor_library=elementor-footer-215


Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/?elementor_library=elementor-footer-215

Rule: tier2.meta.no-og

What it means (plain English)

OpenGraph tags are metadata snippets that tell social media platforms (Facebook, Instagram, LinkedIn) how to

display your site when someone shares a link. Without them, your posts appear plain and generic instead of

showing a custom title, description, and image. This affects how professional and trustworthy your brand looks

when customers share your products on social.

Why it matters for your business: When customers share your dispensary's product pages or promotions on

social media, missing OpenGraph tags cause plain, unattractive previews—reducing click-through rates and

brand perception compared to competitors with rich social cards.

Technical root cause: The site either lacks og:title and og:image meta tags in the <head> section, or they are

not being dynamically generated for template/library URLs. The affected URL is an Elementor library endpoint,

which may not have proper OpenGraph templates configured.

Recommended fix — step by step

1. Check your site's header template (or <head> section in index.html / functions.php if WordPress) for existing

og:title, og:image, og:description, and og:url tags—many themes include these by default.

2. If using WordPress, install Yoast SEO or All in One SEO Pack plugin and enable OpenGraph output:

Dashboard → Yoast SEO → Integrations → Social → toggle 'Add Open Graph meta tags' ON.

3. For each major page (homepage, product pages, blog posts), set a custom OpenGraph image in your SEO

plugin or manually add: <meta property='og:image' content='https://litmospheres.com/path-to-image.jpg'>

4. Add og:title and og:description to homepage and template pages: <meta property='og:title'

content='Litmosphere | Premium Cannabis Products'> and <meta property='og:description' content='[your

value prop]'>

5. For the Elementor library URL, check Elementor Settings → General → Social Sharing—enable og:image

generation or exclude library URLs from indexing if they are internal-only.

6. Test social preview rendering using Facebook Sharing Debugger (facebook.com/developers/tools/debug)

and LinkedIn Post Inspector to confirm tags appear correctly.

35. Title length 18 chars

Severity: P3 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/category/blog/

Rule: tier2.meta.title-length

What it means (plain English)

Your blog category page has a page title (the text that appears in browser tabs and search results) that's only

18 characters long. Search engines prefer titles between 20–65 characters because longer titles give potential

customers more context about what they'll find. A slightly longer title will help searchers understand the page

better and may improve click-through rates from Google.

https://litmospheres.com/?elementor_library=elementor-footer-215
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Why it matters for your business: A weak page title means fewer clicks from search results, which reduces

traffic to your blog content—a key channel for building trust and driving repeat visits to your dispensary site.

Technical root cause: The page's HTML <title> tag contains only "Blog | Litmosphere," which is below the

recommended minimum. Expanding it with descriptive keywords (e.g., "Cannabis Blog | Litmosphere

Dispensary") will meet guidelines without exceeding the 65-character limit.

Recommended fix — step by step

1. Open your site admin / CMS and navigate to the blog category page settings.

2. Locate the SEO or Meta Title field for the blog category page.

3. Change the title from "Blog | Litmosphere" to "Cannabis Blog | Litmosphere Dispensary" (or similar—aim for

50–60 characters).

4. Save and publish the change.

5. Wait 24–48 hours, then check Google Search Console (google.com/webmasters) to confirm the new title

appears in search results.

36. Missing Twitter card

Severity: P3 | Priority: ⚪  LOW

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your homepage doesn't include a Twitter Card meta tag, which tells Twitter how to display your site when

someone shares a link. Without it, Twitter shows a generic preview instead of a branded, engaging one with

your logo, description, and image.

Why it matters for your business: Missed opportunity to drive traffic and build brand recognition when

customers share your dispensary on social media—a plain preview converts far fewer clicks than a rich, visually

appealing one.

Technical root cause: The meta tag <meta name="twitter:card"
content="summary_large_image">  and related Twitter Card directives (og:image, og:description, etc.)

are not present in the HTML head section.

Recommended fix — step by step

1. Open your site's HTML source (right-click → View Page Source or inspect the <head> tag in your CMS)

2. Add these meta tags to the <head> section: <meta name="twitter:card" content="summary_large_image">

<meta name="twitter:site" content="@YourTwitterHandle"><meta name="twitter:title"

content="Litmosphere | Cannabis Dispensary"><meta name="twitter:description" content="[Your 1-2

sentence brand tagline]"><meta name="twitter:image" content="[URL to a 1200×630px logo/hero image]">

3. If using WordPress, install Yoast SEO or All in One SEO Pack, enable Twitter/X integration in settings, and

map your social profile

4. Test the card at cards-dev.twitter.com to ensure it renders correctly

5. Repeat the process for other high-traffic pages (menu, about, product landing pages)

37. Missing Twitter card

https://litmospheres.com/


Severity: P3 | Priority: ⚪  LOW

Effort: Quick win (< 30 min)

Business category: polish

Page URL: https://litmospheres.com/services/

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your website is missing a Twitter Card meta tag, which tells Twitter (X) how to display your page when someone

shares a link. Without it, Twitter shows a generic preview instead of your custom headline, description, and

image. This is cosmetic but affects how professional your brand looks on social media.

Why it matters for your business: When customers share your product pages or services on Twitter/X, you

miss the chance to control the visual impression and drive click-throughs with a branded preview.

Technical root cause: The page lacks the <meta name="twitter:card"
content="summary_large_image">  tag (and related twitter:title, twitter:description, twitter:image tags)

in the HTML head section.

Recommended fix — step by step

1. Open the HTML source of https://litmospheres.com/services/ (or your page template if platform is CMS-

based)

2. Locate the <head> section and add: <meta name="twitter:card"
content="summary_large_image"> , <meta name="twitter:title" content="Your
Page Title"> , <meta name="twitter:description" content="Your Page
Description"> , <meta name="twitter:image"
content="https://litmospheres.com/path-to-image.jpg">

3. Use Twitter's Card Validator (cards-dev.twitter.com/validator) to preview and confirm the card renders

correctly

4. Apply the same tags to all key pages: services, products, homepage

38. Missing Twitter card

Severity: P3 | Priority: ⚪  LOW

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/castleton-on-hudson/

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your website is missing Twitter Card tags, which are special HTML instructions that tell Twitter (now X) how to

display your pages when someone shares a link. Without them, social shares look plain and generic instead of

showing your product photo, brand colors, and compelling description.

Why it matters for your business: Fewer clicks from social media shares; dispensary deals and new product

announcements get less engagement when shared by staff or customers on X/Twitter.

Technical root cause: The page HTML lacks the meta tags twitter:card , twitter:title ,
twitter:description , and twitter:image  in the <head>  section.

Recommended fix — step by step

https://litmospheres.com/services/
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1. Add these four meta tags to the <head>  of your page template (or each page if platform doesn't support

templating): <meta name="twitter:card" content="summary_large_image"> , <meta
name="twitter:title" content="[Page Title]"> , <meta
name="twitter:description" content="[Brief description]"> , <meta
name="twitter:image" content="[URL to 1200x630px image]">

2. Ensure the image URL points to a high-quality product or brand image (minimum 1200×630 pixels).

3. Test the fix using Twitter's Card Validator (cards-dev.twitter.com/validator).

4. If using WordPress, install the Yoast SEO plugin, go to Settings → Titles & Metas → Social, enable Twitter,

and fill in default image + title templates.

5. If on Shopify, use the built-in meta tag editor or a free app like Meta Fields to add tags to product pages.

39. Missing Twitter card

Severity: P3 | Priority: ⚪  LOW

Effort: Quick win (< 30 min)

Business category: polish

Page URL: https://litmospheres.com/contact/

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your website doesn't have Twitter card markup, which means when someone shares a link to your site on

Twitter/X, it won't display a nice preview with your image and description. Instead, Twitter will pull whatever it

can find, and the result looks unprofessional and incomplete.

Why it matters for your business: Missing Twitter cards reduce click-through rates on social shares and hurt

brand perception when customers share your products or promotions on social media.

Technical root cause: The page lacks the <meta name="twitter:card"
content="summary_large_image">  tag and related Twitter metadata in the HTML head section.

Recommended fix — step by step

1. Add <meta name="twitter:card" content="summary_large_image">  to the head of your

page template

2. Add <meta name="twitter:site" content="@YourTwitterHandle">  (replace with your

actual handle)

3. Add <meta name="twitter:title" content="Page Title">  matching your page's main

heading

4. Add <meta name="twitter:description" content="Brief description of page
content">  (50–160 characters)

5. Add <meta name="twitter:image"
content="https://litmospheres.com/path/to/image.jpg">  pointing to a 1200×630px

image

6. Test the updated pages using the Twitter Card Validator (cards-dev.twitter.com/validator)

40. Missing Twitter card

Severity: P3 | Priority: ⚪  LOW

https://litmospheres.com/contact/
https://litmospheres.com/path/to/image.jpg%22%3E


Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/education-community/

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your website is missing a Twitter card meta tag, which is a small code snippet that tells Twitter how to display

your content when someone shares a link on that platform. Without it, Twitter uses generic fallback formatting,

which may not show your product images or brand messaging as intended.

Why it matters for your business: Missing Twitter cards reduce click-through rates from social shares and

make your cannabis education content look less professional or appealing when shared on Twitter/X, potentially

limiting organic reach and brand visibility.

Technical root cause: The page HTML does not include the Open Graph meta tag <meta
name="twitter:card" content="summary_large_image">  or equivalent, which is optional but

recommended for social sharing optimization.

Recommended fix — step by step

1. Add this meta tag to the <head> section of your affected page (education-community): <meta
name="twitter:card" content="summary_large_image">

2. Add <meta name="twitter:image" content="[full URL to your logo or key
image]">  to specify which image displays when shared

3. Add <meta name="twitter:title" content="[your page title]">  and <meta
name="twitter:description" content="[your page description]">  for consistency

4. If you use WordPress, install the Yoast SEO or Rank Math plugin, go to Integrations → Social Media, toggle

Twitter/X ON, and set your Twitter handle — these plugins auto-generate Twitter cards

5. Test the card using Twitter's Card Validator (cards-dev.twitter.com/validator) by pasting your URL to confirm

it displays correctly

41. Missing Twitter card

Severity: P3 | Priority: ⚪  LOW

Effort: Quick win (< 30 min)

Business category: polish

Page URL: https://litmospheres.com/about-us/

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your website is missing a Twitter Card meta tag, which is a snippet of code that tells Twitter (now X) how to

display a preview when someone shares your About Us page. Without it, X shows a plain, generic preview

instead of a branded one with your chosen image, title, and description.

Why it matters for your business: When customers share your About Us page on X, a weak preview reduces

click-through rates and brand perception compared to competitors who have polished social previews.

Technical root cause: The <meta name="twitter:card" content="summary_large_image">
tag and related Open Graph meta tags are not present in the page's HTML head section.

Recommended fix — step by step

https://litmospheres.com/education-community/
https://litmospheres.com/about-us/


1. Open your About Us page HTML in a code editor or via your CMS admin panel

2. Locate the <head>  section of the page

3. Add the following meta tags after your existing Open Graph tags: <meta name="twitter:card"
content="summary_large_image"><meta name="twitter:site"
content="@YourTwitterHandle"><meta name="twitter:title" content="About
Litmosphere"><meta name="twitter:description" content="[Your 2-sentence
brand description]"><meta name="twitter:image" content="[URL to 1200x630px
branded image]">

4. Replace @YourTwitterHandle with your actual X handle and the image URL with a high-quality Litmosphere

brand image hosted on your server

5. Test the preview using the X Card Validator (https://cards-dev.twitter.com/validator) by entering your About

Us URL

6. Once validated, apply the same Twitter Card tags to your homepage and key landing pages (products,

contact)

42. Missing Twitter card

Severity: P3 | Priority: ⚪  LOW

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/accessibility/

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your site is missing a Twitter Card meta tag, which tells Twitter (now X) how to display your content when

someone shares a link. Without it, X shows a plain text preview instead of a rich preview with your brand

imagery and product details. This is purely cosmetic on social sharing—it doesn't affect your core site

functionality.

Why it matters for your business: When customers share your product pages or promotions on X, the post

looks generic and less engaging, reducing click-through rates and brand presence in social conversations.

Technical root cause: The page HTML is missing the <meta name="twitter:card"
content="summary_large_image">  tag (or variant) in the document head, and no corresponding Open

Graph tags that Twitter can fall back to.

Recommended fix — step by step

1. Add this meta tag to your site's <head>  section (or header template if using a CMS): <meta
name="twitter:card" content="summary_large_image"><meta name="twitter:site"
content="@YourXHandle"><meta name="twitter:image"
content="https://litmospheres.com/path-to-brand-image.jpg">

2. Ensure the image is at least 1200×630 pixels and under 5MB

3. Test the card rendering at https://cards-dev.twitter.com/validator

4. If using WordPress, install Yoast SEO or Rank Math, go to their Social settings, and enable X/Twitter card

generation

43. Missing Twitter card
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Severity: P3 | Priority: ⚪  LOW

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/?elementor_library=insta

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your site is missing a Twitter Card meta tag, which tells Twitter how to display your content when someone

shares a link to your site on that platform. Without it, Twitter shows a plain text preview instead of a rich preview

with your brand colors, images, and product details.

Why it matters for your business: When customers share your products or promotions on Twitter/X, the posts

look generic instead of branded and eye-catching, reducing click-through rates and social engagement for your

cannabis retail.

Technical root cause: The meta tag <meta name="twitter:card"
content="summary_large_image">  is not present in the HTML head section. This is a simple metadata

addition that most site builders support but isn't set by default.

Recommended fix — step by step

1. Log into your site admin (or contact your web host if you manage code directly).

2. Locate your page head template or global meta tag settings (in WordPress, use Yoast SEO or RankMath

plugin; in Elementor, check Theme Settings → Integration).

3. Add the meta tag: <meta name="twitter:card" content="summary_large_image">  in the

head section.

4. Also add <meta name="twitter:image" content="[your-brand-logo-or-product-
image-url]">  to specify which image displays.

5. Test the fix at https://cards-dev.twitter.com/ by pasting your URL to verify the card renders correctly.

6. Clear your site cache (if using a caching plugin like WP Super Cache or Cloudflare) to ensure updates are

live.

44. Missing OpenGraph metadata

Severity: P3 | Priority: ⚪  LOW

Effort: Quick win (< 30 min)

Business category: polish

Page URL: https://litmospheres.com/?elementor_library=elementor-header-209

Rule: tier2.meta.no-og

What it means (plain English)

Your site is missing OpenGraph tags, which are snippets of code that tell social media platforms (Facebook,

Instagram, LinkedIn) how to display your content when someone shares a link. Without them, social shares

show up as plain links with no image or description, making them look unprofessional and reducing click-

through rates.

Why it matters for your business: Poor social media presentation hurts word-of-mouth and paid social

campaigns, especially important for a fun cannabis brand where visual appeal and shareability drive customer

acquisition.

https://litmospheres.com/?elementor_library=insta
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Technical root cause: The affected URL is an Elementor library page (a backend template page, not a public-

facing page). These pages typically don't need OpenGraph tags, but the scanner flagged it because the tags

are absent. This is likely a false positive—the URL shouldn't be indexed or shared publicly in the first place.

Recommended fix — step by step

1. Verify that the URL https://litmospheres.com/?elementor_library=elementor-header-209 is not publicly

accessible or indexed by checking Google Search Console (search.google.com) under 'Coverage' tab for

this URL

2. If this Elementor library page is appearing in search results, add a noindex directive: go to your site settings

and add 'noindex' to the header of all Elementor library URLs, or use a robots.txt rule to block ?

elementor_library= URLs entirely

3. For your public-facing pages that ARE shared socially (homepage, product pages, blog posts), add

OpenGraph meta tags in the <head>: og:title, og:image (1200×630px minimum), og:description, and og:url

4. If you're using a WordPress plugin, install Yoast SEO or Rank Math (both free versions include OpenGraph

generation) and configure them under the social settings to auto-populate tags from your page titles and

featured images

45. Missing Twitter card

Severity: P3 | Priority: ⚪  LOW

Effort: Quick win (< 30 min)

Business category: polish

Page URL: https://litmospheres.com/?elementor_library=elementor-header-209

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your website is missing Twitter card metadata — a snippet of code that tells Twitter (X) how to display your

content when someone shares a link. Without it, Twitter shows a plain, generic preview instead of your brand

colors, images, and description. This is a cosmetic issue that doesn't block sharing.

Why it matters for your business: Shared links to your dispensary's products or promotions will appear less

visually appealing on Twitter, reducing click-through rates and brand recall when customers share your site on

social media.

Technical root cause: The <meta name="twitter:card">  tag and related Twitter Open Graph tags

(twitter:title, twitter:description, twitter:image) are not present in the page's <head>  section.

Recommended fix — step by step

1. Log in to your WordPress admin → Appearance → Theme File Editor (or use a custom code plugin like Code

Snippets)

2. Open your theme's header.php file or add code via a custom hook to the <head>  section

3. Add these meta tags: <meta name="twitter:card" content="summary_large_image"> ,
<meta name="twitter:title" content="Your Brand Name"> , <meta
name="twitter:description" content="Your dispensary description"> , <meta
name="twitter:image" content="[URL to your logo or product image]">

4. Alternatively, install Yoast SEO or Rank Math plugin → Social → Twitter → enable Twitter card and set default

image

5. Test the fix at https://cards-dev.twitter.com/ by pasting your homepage URL

https://litmospheres.com/?elementor_library=elementor-header-209
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46. Missing Twitter card

Severity: P3 | Priority: ⚪  LOW

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://litmospheres.com/?elementor_library=elementor-footer-215

Rule: tier2.meta.no-twitter-card

What it means (plain English)

Your site is missing a Twitter Card meta tag, which is a small code snippet that tells Twitter (now X) how to

display your pages when someone shares a link. Without it, shared links appear plain and less engaging. This is

a social media visibility feature, not a search engine requirement.

Why it matters for your business: When customers or influencers share your dispensary's product pages or

promotions on Twitter/X, they'll display as plain text instead of rich cards with images and descriptions,

reducing click-through rates and social engagement.

Technical root cause: The page's HTML header is missing the <meta name="twitter:card"
content="summary_large_image">  tag (or equivalent variant). This is often overlooked when

Elementor-based sites don't have a social sharing plugin configured.

Recommended fix — step by step

1. Install and activate the Yoast SEO plugin (free version includes Twitter Card support) or Rank Math SEO

plugin

2. In your plugin settings, navigate to the Social Media integration section

3. Enter your Twitter/X handle and set the preferred card type to 'summary_large_image'

4. The plugin will auto-generate the required meta tag on all pages

5. Test a product page share at cards-dev.twitter.com to confirm the card renders correctly

47. Description length 18 chars

Severity: P3

Page URL: https://litmospheres.com/category/blog/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

48. Missing OpenGraph metadata

Severity: P3

Page URL: https://litmospheres.com/category/blog/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://litmospheres.com/?elementor_library=elementor-footer-215
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49. Missing Twitter card

Severity: P3

Page URL: https://litmospheres.com/category/blog/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

50. 2 image(s) missing alt text

Severity: P3

Page URL: https://litmospheres.com/category/blog/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

51. Desktop perf measurement failed

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier3.perf.desktop-fail

Detail

page.goto: Timeout 60000ms exceeded.

Call log:

navigating to "https://litmospheres.com/", waiting until "networkidle"

52. Missing security header: x-content-type-options

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier5.header.x-content-type-options

Detail

x-content-type-options not present on homepage response. Affects fortress score and CSP posture.

53. Missing security header: referrer-policy

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier5.header.referrer-policy

Detail

https://litmospheres.com/category/blog/
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referrer-policy not present on homepage response. Affects fortress score and CSP posture.

54. Missing security header: permissions-policy

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier5.header.permissions-policy

Detail

permissions-policy not present on homepage response. Affects fortress score and CSP posture.

55. Cookie missing SameSite flag

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier5.cookie.no-samesite

Detail

Cookies should declare SameSite=Lax or Strict.

56. SSL Labs grade: unknown

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier5.fortress.ssl-grade

Detail

Qualys SSL Labs: SSL Labs HTTP 400. Aim for A+ via strong TLS 1.3, HSTS, CAA, and preload.

57. DNSSEC not enabled

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier5.fortress.dnssec-missing

Detail

DNSSEC adds cryptographic verification to DNS responses. Consider enabling via your registrar.

58. No CAA DNS records

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier5.fortress.caa-missing

Detail

https://litmospheres.com/
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CAA records restrict which CAs may issue certs for your domain, preventing rogue issuance. Add CAA for

letsencrypt.org / digicert.com / etc.

59. No DKIM selectors found (standard selectors)

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier5.fortress.dkim-missing

Detail

Tried selectors: google, default, selector1, selector2, s1, k1 — none matched at litmospheres.com. DKIM

improves deliverability + anti-spoofing.

60. Lighthouse bestPractices (mobile): 79/100

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier8.lighthouse.bestPractices-mobile

Detail

Score 79 is below target 90. See HTML report for details.

61. Lighthouse seo (mobile): 85/100

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier8.lighthouse.seo-mobile

Detail

Score 85 is below target 95. See HTML report for details.

62. LH mobile: Preconnect to required origins (Est savings of 330 ms)

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier8.lh-opportunity.uses-rel-preconnect-mobile

Detail

Consider adding preconnect  or dns-prefetch  resource hints to establish early connections to

important third-party origins. https://developer.chrome.com/docs/lighthouse/performance/uses-rel-

preconnect/" target="_blank" rel="noreferrer">Learn how to preconnect to required origins.

63. LH mobile: Eliminate render-blocking resources (Est savings of

1,070 ms)

Severity: P3

https://litmospheres.com/
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Page URL: https://litmospheres.com/

Rule: tier8.lh-opportunity.render-blocking-resources-mobile

Detail

Resources are blocking the first paint of your page. Consider delivering critical JS/CSS inline and deferring all

non-critical JS/styles. https://developer.chrome.com/docs/lighthouse/performance/render-blocking-resources/"

target="_blank" rel="noreferrer">Learn how to eliminate render-blocking resources.

64. LH mobile: Minify JavaScript (Est savings of 5 KiB)

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier8.lh-opportunity.unminified-javascript-mobile

Detail

Minifying JavaScript files can reduce payload sizes and script parse time.

https://developer.chrome.com/docs/lighthouse/performance/unminified-javascript/" target="_blank"

rel="noreferrer">Learn how to minify JavaScript.

65. LH mobile: Reduce unused CSS (Est savings of 26 KiB)

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier8.lh-opportunity.unused-css-rules-mobile

Detail

Reduce unused rules from stylesheets and defer CSS not used for above-the-fold content to decrease bytes

consumed by network activity. https://developer.chrome.com/docs/lighthouse/performance/unused-css-rules/"

target="_blank" rel="noreferrer">Learn how to reduce unused CSS.

66. LH mobile: Reduce unused JavaScript (Est savings of 121 KiB)

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier8.lh-opportunity.unused-javascript-mobile

Detail

Reduce unused JavaScript and defer loading scripts until they are required to decrease bytes consumed by

network activity. https://developer.chrome.com/docs/lighthouse/performance/unused-javascript/"

target="_blank" rel="noreferrer">Learn how to reduce unused JavaScript.

67. Lighthouse perf (desktop): 76/100

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier8.lighthouse.perf-desktop

https://litmospheres.com/
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Detail

Score 76 is below target 90. See HTML report for details.

68. Lighthouse bestPractices (desktop): 78/100

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier8.lighthouse.bestPractices-desktop

Detail

Score 78 is below target 90. See HTML report for details.

69. Lighthouse seo (desktop): 85/100

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier8.lighthouse.seo-desktop

Detail

Score 85 is below target 95. See HTML report for details.

70. LH desktop: Preconnect to required origins (Est savings of 220 ms)

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier8.lh-opportunity.uses-rel-preconnect-desktop

Detail

Consider adding preconnect  or dns-prefetch  resource hints to establish early connections to

important third-party origins. https://developer.chrome.com/docs/lighthouse/performance/uses-rel-

preconnect/" target="_blank" rel="noreferrer">Learn how to preconnect to required origins.

71. LH desktop: Preload Largest Contentful Paint image

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier8.lh-opportunity.prioritize-lcp-image-desktop

Detail

If the LCP element is dynamically added to the page, you should preload the image in order to improve LCP.

https://web.dev/articles/optimize-lcp#optimize_when_the_resource_is_discovered" target="_blank"

rel="noreferrer">Learn more about preloading LCP elements.

72. LH desktop: Eliminate render-blocking resources (Est savings of

310 ms)

https://litmospheres.com/
https://litmospheres.com/
https://litmospheres.com/
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Severity: P3

Page URL: https://litmospheres.com/

Rule: tier8.lh-opportunity.render-blocking-resources-desktop

Detail

Resources are blocking the first paint of your page. Consider delivering critical JS/CSS inline and deferring all

non-critical JS/styles. https://developer.chrome.com/docs/lighthouse/performance/render-blocking-resources/"

target="_blank" rel="noreferrer">Learn how to eliminate render-blocking resources.

73. LH desktop: Minify JavaScript (Est savings of 5 KiB)

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier8.lh-opportunity.unminified-javascript-desktop

Detail

Minifying JavaScript files can reduce payload sizes and script parse time.

https://developer.chrome.com/docs/lighthouse/performance/unminified-javascript/" target="_blank"

rel="noreferrer">Learn how to minify JavaScript.

74. LH desktop: Reduce unused CSS (Est savings of 26 KiB)

Severity: P3

Page URL: https://litmospheres.com/

Rule: tier8.lh-opportunity.unused-css-rules-desktop

Detail

Reduce unused rules from stylesheets and defer CSS not used for above-the-fold content to decrease bytes

consumed by network activity. https://developer.chrome.com/docs/lighthouse/performance/unused-css-rules/"

target="_blank" rel="noreferrer">Learn how to reduce unused CSS.

Findings by Page

Grouped by URL — useful when working through the site one page at a time.

https://litmospheres.com/

_44 findings on this page_

[P1] 1 mixed-content references (http://) 🔴  DO FIRST

Your website is served over HTTPS (secure), but it's trying to load a resource from an HTTP URL (insecure).

Modern browsers block or warn about this, which can degrade trust and break functionality. I

[P1] A11y: ARIA dialog and alertdialog nodes should have an accessible name 🔴  DO FIRST
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Your age-gate dialog (the overlay that appears when visitors first land on your site) doesn't have a label that

screen readers can announce. Screen reader users don't know what the dialog is for or ho

[P1] Journey failed: default: homepage → age gate → menu visible 🔴  DO FIRST

Your site is trying to load a JavaScript module (a .js file imported with type="module" ) but the server is
sending back an HTML page instead. This breaks the age gate and menu functionality on the h

[P2] 11 image(s) missing alt text

[P2] Mobile perf measurement failed 🟠  HIGH

Our automated performance testing tool timed out while trying to load your homepage on a mobile connection

— it waited 60 seconds and never received a signal that the page had finished loading all res

[P2] Missing core schema types: LocalBusiness

[P2] Missing security header: strict-transport-security 🟠  HIGH

Your site is missing the Strict-Transport-Security (HSTS) header, which tells browsers to always use HTTPS

when connecting to your domain. Without it, visitors could be vulnerable to man-in-the-middle

[P2] Missing security header: x-frame-options 🟠  HIGH

Your site is missing the X-Frame-Options security header, which tells browsers whether your pages can be

embedded inside frames or iframes on other websites. Without this header, malicious sites could

[P2] Missing security header: content-security-policy 🟠  HIGH

Your site is missing a Content Security Policy (CSP) header — a security rule that tells browsers which external

resources (scripts, images, fonts) are allowed to load. Without it, attackers could inj

[P2] Cookie missing Secure flag 🟠  HIGH

Your website sets a cookie (nfd-enable-cf-opt) without the Secure flag. This flag tells browsers to only send the

cookie over encrypted HTTPS connections, not unencrypted HTTP. Without it, if a visito

[P2] No DMARC policy published 🟠  HIGH

Your domain has a valid SPF record (which helps prevent email spoofing) but is missing a DMARC policy—a set

of instructions that tell email providers how to handle emails claiming to be from your doma

[P2] 57 tap targets under 44px at mobile-320 🟠  HIGH

Your homepage has 57 buttons, links, and interactive elements that are smaller than 44×44 pixels when viewed

on a mobile phone at 320px width. This makes them hard to tap accurately—especially for cus

[P2] 56 tap targets under 44px at mobile-375 🟠  HIGH

Your site has 56 interactive buttons and links that are smaller than 44×44 pixels when viewed on a mobile

phone (375px width). This makes them hard to tap accurately, especially for people with limite

[P2] 57 tap targets under 44px at mobile-414 🟠  HIGH

Your website has 57 interactive buttons, links, and input fields that are smaller than 44×44 pixels on mobile

phones. This makes them hard to tap accurately—especially for customers with larger finger

[P2] 25 tap targets under 44px at tablet-768 🟠  HIGH

Your website has 25 buttons, links, and interactive elements that are smaller than 44x44 pixels when viewed on

tablets. This makes them hard to tap accurately—especially for people with motor control

[P2] Lighthouse perf (mobile): 58/100 🟠  HIGH



Your mobile site takes over 31 seconds for the largest visual element (like a hero image or product photo) to

appear. That's roughly 6× slower than Google's recommended 2.5 seconds. Most visitors will

[P2] A11y: Heading levels should only increase by one (×2) 🟠  HIGH

Your homepage uses heading level 5 (h5) tags as primary section headers without proper hierarchy. Screen

readers and search engines expect headings to follow a logical order—typically starting with h1

[P3] Title length 18 chars 🟡  MEDIUM

Your homepage title tag (the text that appears in browser tabs and search results) is only 18 characters long.

Search engines prefer titles between 20–65 characters because longer, descriptive titles

[P3] Missing OpenGraph metadata 🟡  MEDIUM

When your website is shared on Facebook, Instagram, or other social platforms, these pages pull in a preview

image and title automatically. Without OpenGraph metadata, social posts show a generic or b

[P3] Missing Twitter card ⚪  LOW

Your homepage doesn't include a Twitter Card meta tag, which tells Twitter how to display your site when

someone shares a link. Without it, Twitter shows a generic preview instead of a branded, engagi

[P3] Desktop perf measurement failed

[P3] Missing security header: x-content-type-options

[P3] Missing security header: referrer-policy

[P3] Missing security header: permissions-policy

[P3] Cookie missing SameSite flag

[P3] SSL Labs grade: unknown

[P3] DNSSEC not enabled

[P3] No CAA DNS records

[P3] No DKIM selectors found (standard selectors)

[P3] Lighthouse bestPractices (mobile): 79/100

[P3] Lighthouse seo (mobile): 85/100

[P3] LH mobile: Preconnect to required origins (Est savings of 330 ms)

[P3] LH mobile: Eliminate render-blocking resources (Est savings of 1,070 ms)

[P3] LH mobile: Minify JavaScript (Est savings of 5 KiB)

[P3] LH mobile: Reduce unused CSS (Est savings of 26 KiB)

[P3] LH mobile: Reduce unused JavaScript (Est savings of 121 KiB)

[P3] Lighthouse perf (desktop): 76/100

[P3] Lighthouse bestPractices (desktop): 78/100

[P3] Lighthouse seo (desktop): 85/100

[P3] LH desktop: Preconnect to required origins (Est savings of 220 ms)

[P3] LH desktop: Preload Largest Contentful Paint image

[P3] LH desktop: Eliminate render-blocking resources (Est savings of 310 ms)

[P3] LH desktop: Minify JavaScript (Est savings of 5 KiB)

[P3] LH desktop: Reduce unused CSS (Est savings of 26 KiB)

https://litmospheres.com/category/blog/

_5 findings on this page_

https://litmospheres.com/category/blog/


[P3] Title length 18 chars 🟡  MEDIUM

Your blog category page has a page title (the text that appears in browser tabs and search results) that's only

18 characters long. Search engines prefer titles between 20–65 characters because longer

[P3] Description length 18 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 2 image(s) missing alt text

https://litmospheres.com/?elementor_library=insta

_4 findings on this page_

[P2] 11 image(s) missing alt text

[P3] Title length 18 chars 🟡  MEDIUM

Your homepage title tag (the text that appears in browser tabs and search results) is only 18 characters long.

Search engines prefer titles between 20–65 characters because longer, descriptive titles

[P3] Missing OpenGraph metadata 🟡  MEDIUM

OpenGraph tags are snippets of code that control how your website appears when shared on social media

platforms like Instagram, Facebook, and Twitter. Without these tags, your pages show up with gener

[P3] Missing Twitter card ⚪  LOW

Your site is missing a Twitter Card meta tag, which tells Twitter how to display your content when someone

shares a link to your site on that platform. Without it, Twitter shows a plain text preview i

https://litmospheres.com/?elementor_library=default-kit

_4 findings on this page_

[P2] 11 image(s) missing alt text 🟠  HIGH

Eleven images on your site are missing alt text — a text description that explains what each image shows.

Screen readers used by visually impaired customers can't describe these images, and search eng

[P3] Title length 18 chars 🟡  MEDIUM

Your homepage title tag (the text that appears in browser tabs and search results) is only 18 characters long.

Search engines and users prefer titles between 20 and 65 characters because longer titles

[P3] Missing OpenGraph metadata 🟡  MEDIUM

Open Graph tags are invisible snippets of code that tell social media platforms (Facebook, Instagram, LinkedIn)

how to display your content when someone shares a link. Without them, your posts will sh

[P3] Missing Twitter card 🟡  MEDIUM

Your site is missing a Twitter card meta tag, which is a small piece of code that tells Twitter how to display your

page when someone shares a link on that platform. Without it, Twitter shows a plain

https://litmospheres.com/?elementor_library=elementor-header-209

_4 findings on this page_

https://litmospheres.com/?elementor_library=insta
https://litmospheres.com/?elementor_library=default-kit
https://litmospheres.com/?elementor_library=elementor-header-209


[P2] 11 image(s) missing alt text

[P3] Title length 18 chars 🟡  MEDIUM

Your homepage title tag is only 18 characters long, falling slightly short of the recommended minimum of 20

characters. Title tags are the headline that appears in browser tabs and search results, so

[P3] Missing OpenGraph metadata ⚪  LOW

Your site is missing OpenGraph tags, which are snippets of code that tell social media platforms (Facebook,

Instagram, LinkedIn) how to display your content when someone shares a link. Without them, s

[P3] Missing Twitter card ⚪  LOW

Your website is missing Twitter card metadata — a snippet of code that tells Twitter (X) how to display your

content when someone shares a link. Without it, Twitter shows a plain, generic preview inst

https://litmospheres.com/?elementor_library=elementor-footer-215

_4 findings on this page_

[P2] 11 image(s) missing alt text

[P3] Title length 18 chars 🟡  MEDIUM

Your homepage title is only 18 characters long, falling short of Google's recommended 20–65 character range.

Search engines use this title to display your site in results, and a very short title waste

[P3] Missing OpenGraph metadata 🟡  MEDIUM

OpenGraph tags are metadata snippets that tell social media platforms (Facebook, Instagram, LinkedIn) how to

display your site when someone shares a link. Without them, your posts appear plain and gen

[P3] Missing Twitter card ⚪  LOW

Your site is missing a Twitter Card meta tag, which is a small code snippet that tells Twitter (now X) how to

display your pages when someone shares a link. Without it, shared links appear plain and l

https://litmospheres.com/hello-world/

_3 findings on this page_

[P3] Missing OpenGraph metadata 🟡  MEDIUM

Your blog post page is missing Open Graph tags—special metadata that tells Facebook, Instagram, LinkedIn,

and other social platforms how to display your content when someone shares it. Without these t

[P3] Missing Twitter card 🟡  MEDIUM

Your site is missing a Twitter Card meta tag, which is a small code snippet that tells Twitter (X) how to display

your content when someone shares a link. Without it, Twitter shows a plain link with m

[P3] 3 image(s) missing alt text 🟡  MEDIUM

Three images on your 'Hello World' page don't have alt text — a short text description that tells screen readers

and search engines what the image shows. This makes those images invisible to people us

https://litmospheres.com/services/

_3 findings on this page_
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https://litmospheres.com/services/


[P2] 7 image(s) missing alt text 🟠  HIGH

Seven images on your Services page don't have alt text — short descriptive labels that explain what the image

shows. Screen readers used by visually impaired customers can't describe these images, and

[P3] Missing OpenGraph metadata 🟡  MEDIUM

Your Services page doesn't include Open Graph tags — special metadata that tells social media platforms

(Facebook, Instagram, LinkedIn) what image and headline to display when someone shares your link

[P3] Missing Twitter card ⚪  LOW

Your website is missing a Twitter Card meta tag, which tells Twitter (X) how to display your page when someone

shares a link. Without it, Twitter shows a generic preview instead of your custom headlin

https://litmospheres.com/castleton-on-hudson/

_3 findings on this page_

[P3] Missing OpenGraph metadata 🟡  MEDIUM

When your product pages are shared on social media (Facebook, Instagram, LinkedIn), those platforms look for

special metadata tags called OpenGraph tags to display a preview with your page title and i

[P3] Missing Twitter card ⚪  LOW

Your website is missing Twitter Card tags, which are special HTML instructions that tell Twitter (now X) how to

display your pages when someone shares a link. Without them, social shares look plain an

[P3] 4 image(s) missing alt text 🟠  HIGH

Four images on your Castleton-on-Hudson location page don't have alt text—descriptive labels that screen

readers use to tell visually impaired visitors what an image shows. This means those visitors g

https://litmospheres.com/contact/

_3 findings on this page_

[P2] 5 image(s) missing alt text 🟠  HIGH

Your contact page has 5 out of 6 images missing alt text — short descriptions that explain what each image

shows. Search engines can't read images, so they rely on alt text to understand your content.

[P3] Missing OpenGraph metadata 🟡  MEDIUM

OpenGraph metadata tells social media platforms (Facebook, Instagram, LinkedIn) how to display your page

when someone shares it. Without og:title and og:image, your contact page will show a generic pr

[P3] Missing Twitter card ⚪  LOW

Your website doesn't have Twitter card markup, which means when someone shares a link to your site on

Twitter/X, it won't display a nice preview with your image and description. Instead, Twitter will

https://litmospheres.com/in-store-pickup/

_3 findings on this page_

[P3] Missing OpenGraph metadata 🟡  MEDIUM

https://litmospheres.com/castleton-on-hudson/
https://litmospheres.com/contact/
https://litmospheres.com/in-store-pickup/


When people share your in-store pickup page on social media (Facebook, Instagram, etc.), those platforms

don't have a nice preview card to display. Instead, they show a generic or broken-looking snipp

[P3] Missing Twitter card 🟡  MEDIUM

Your website is missing Twitter Card tags, which are special metadata that tell Twitter (now X) how to display

your pages when someone shares a link. Without them, the platform shows a plain, unformat

[P3] 3 image(s) missing alt text 🟡  MEDIUM

Three images on your in-store pickup page don't have alt text—descriptive labels that screen readers use to tell

visually impaired visitors what an image shows. This hurts both accessibility (people u

https://litmospheres.com/online-ordering/

_3 findings on this page_

[P3] Missing OpenGraph metadata 🟡  MEDIUM

OpenGraph (OG) tags are snippets of code that control how your pages look when shared on Facebook,

Instagram, LinkedIn, and other social platforms. Without og:title and og:image tags, when someone sha

[P3] Missing Twitter card 🟡  MEDIUM

Your site is missing a Twitter Card meta tag, which is a snippet of code that tells Twitter how to display your

page when someone shares it on that platform. Without it, Twitter shows a plain, unforma

[P3] 3 image(s) missing alt text 🟡  MEDIUM

Three images on your online ordering page lack alt text — descriptive text that screen readers announce to

visitors with visual impairments, and that search engines use to understand what images show.

https://litmospheres.com/education-community/

_3 findings on this page_

[P2] 9 image(s) missing alt text

[P3] Missing OpenGraph metadata 🟡  MEDIUM

When your Education & Community page is shared on social media (Facebook, Instagram, LinkedIn), those

platforms need specific metadata tags to know what title and image to display in the preview. With

[P3] Missing Twitter card ⚪  LOW

Your website is missing a Twitter card meta tag, which is a small code snippet that tells Twitter how to display

your content when someone shares a link on that platform. Without it, Twitter uses gene

https://litmospheres.com/about-us/

_3 findings on this page_

[P2] 7 image(s) missing alt text 🟠  HIGH

Seven images on your About Us page don't have alt text — descriptive text that explains what each image

shows. Search engines and screen readers (used by people with vision impairments) can't understa

[P3] Missing OpenGraph metadata 🟡  MEDIUM

https://litmospheres.com/online-ordering/
https://litmospheres.com/education-community/
https://litmospheres.com/about-us/


Your About Us page is missing OpenGraph metadata—special tags that control how your page appears when

shared on Facebook, Instagram, or other social platforms. Without these tags, when someone shares

[P3] Missing Twitter card ⚪  LOW

Your website is missing a Twitter Card meta tag, which is a snippet of code that tells Twitter (now X) how to

display a preview when someone shares your About Us page. Without it, X shows a plain, gen

https://litmospheres.com/accessibility/

_3 findings on this page_

[P3] Missing OpenGraph metadata 🟡  MEDIUM

Your /accessibility/ page is missing OpenGraph tags — special HTML code that tells social media platforms

(Facebook, Instagram, LinkedIn) what to display when someone shares the link. Without these ta

[P3] Missing Twitter card ⚪  LOW

Your site is missing a Twitter Card meta tag, which tells Twitter (now X) how to display your content when

someone shares a link. Without it, X shows a plain text preview instead of a rich preview wit

[P3] 2 image(s) missing alt text 🟡  MEDIUM

Your accessibility page contains 2 images that lack descriptive alt text — the hidden labels that screen readers

announce to visually impaired visitors and that search engines use to understand image

https://litmospheres.com/cannabis-dispensary-castleton-on-hudson-ny/

_3 findings on this page_

[P2] 12 image(s) missing alt text

[P3] Missing OpenGraph metadata 🟡  MEDIUM

When someone shares your dispensary location page on Facebook, Instagram, or other social platforms, those

platforms pull in a preview image and headline. Without OpenGraph metadata (special tags that

[P3] Missing Twitter card 🟡  MEDIUM

Your product pages are missing Twitter Card meta tags — special HTML code that tells Twitter how to display

your content when someone shares a link to your site on Twitter/X. Without this, your posts

https://litmospheres.com/dispensary-schodack-ny/

_3 findings on this page_

[P2] 12 image(s) missing alt text 🟠  HIGH

Twelve images on your Schodack dispensary page are missing alt text — descriptive labels that screen readers

announce to visually impaired visitors and that search engines read to understand image con

[P3] Missing OpenGraph metadata 🟡  MEDIUM

Open Graph tags are snippets of code that tell social media platforms (Facebook, Instagram, LinkedIn) how to

display your page when someone shares it. Without og:title and og:image, your dispensary's

[P3] Missing Twitter card 🟡  MEDIUM

https://litmospheres.com/accessibility/
https://litmospheres.com/cannabis-dispensary-castleton-on-hudson-ny/
https://litmospheres.com/dispensary-schodack-ny/


Your product pages are missing Twitter Card tags, which are small code snippets that tell Twitter how to display

your link when someone shares it on that platform. Without them, Twitter shows a plain,

https://litmospheres.com/dispensary-near-east-greenbush-ny/

_3 findings on this page_

[P2] 12 image(s) missing alt text 🟠  HIGH

Twelve images on your East Greenbush dispensary page don't have alt text—descriptive labels that screen

readers announce to blind and low-vision visitors, and that search engines use to understand ima

[P3] Missing OpenGraph metadata 🟡  MEDIUM

Open Graph tags are snippets of code that tell social platforms (Facebook, Instagram, LinkedIn) what image and

text to display when someone shares your link. Without them, your dispensary page shows u

[P3] Missing Twitter card 🟡  MEDIUM

Your product pages are missing Twitter card metadata — special HTML tags that tell Twitter (now X) how to

display your content when someone shares a link. Without them, the platform shows a plain, gen

https://litmospheres.com/robots.txt

_1 finding on this page_

[P3] robots.txt does not reference sitemap 🟡  MEDIUM

Your robots.txt file (the instruction file that tells search engines how to crawl your site) doesn't point to your

XML sitemap. A sitemap is a roadmap of all your pages that helps search engines find

https://litmospheres.com/wp-login.php

_1 finding on this page_

[P0] Sensitive artifact exposed: /wp-login.php 🔴  DO FIRST

Your WordPress login page is publicly accessible at /wp-login.php. This is a common attack target where

hackers try to break into your site by guessing usernames and passwords. While WordPress is inst
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